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Welcome to iSynergy 3.9! 
iSynergy is the award-winning browser based content management platform designed to simply 
integrate business process automation, human resource allocation and document management in 
one simple to deploy application that empowers users to innovate how they manage and share 
content with the enterprise. As a comprehensive information management solution that provides 
user-friendly solutions for the capture, storage, exchange, revision, and protection of business 
documents in a digital environment. iSynergy dramatically enhances personnel productivity while 
simultaneously reducing the cost of running a business. Using a standard browser interface, 
employees, customers, and vendors can easily access information they need. 

iSynergy is built on an open platform that allows for the expansion of its base capabilities. It easily 
connects to host and legacy systems, expanding the functionality and leveraging the value of a 
company’s current hardware and software investments. 

Moreover, iSynergy maintains a central, enterprise-wide repository for the storage of all 
Documents, unstructured information, and files that comprise a company’s intellectual property. 
iSynergy empowers a company with the means to create new information management solutions 
that automate many business operations. This empowerment is possible without the need to 
understand programming or scripting.  

iSynergy users may employ search functionality to retrieve documents which they have 
permission to access. Once a User retrieves a document, they can: view, manage, share, and 
reproduce the information. Some of these functions are dependent on permissions granted by the 
System Administrator. Searches can be very broad or more specific in nature depending on the 
desired result set of the search performed. 

iSynergy can be finely tuned to grant highly granular access rights to individual iSynergy users. 
For example, a customer service representative may be granted unlimited access to Applications 
that contain public information, moderate levels of access to pricing information and denied any 
access to confidential information. iSynergy makes it easy to selectively control access rights to 
information for each individual User.  

iDatix engineered iSynergy on popular development platforms. All of our software products 
conform to RAD (rapid application development), ODBC (open data base connectivity) and other 
industry-wide software development standards. iDatix has ensured that iSynergy smoothly 
integrates with enterprise networks. In addition, in-house customization is possible for all 
organizations. 

What’s new in 3.9 
iSynergy 3.9 furthers the iDatix mission to Simplify the Workplace for your growing business. In 
this release, iDatix has added customer requested feature enhancements to make iSynergy 
simple to use, as well as enabling the user to boost organization efficiency and work throughput. 

The highlights of this release include: 

 Revision Control. iSynergy provides support for collaborative document 
development and process document modifications. The Revision Control feature 
is a seamless extension to the iSynergy User Interface that completely integrates 
the full functionality of the MS Office suite. In 3.9, iSynergy supports document 
versioning and maintains a complete history and audit trail for all document 
changes. 

 Application Level Permissions. Application Level Permissions now provide the 
ability to control user and group permissions on a per application basis. The 
iSynergy user who creates an application now has the ability to add indexes 
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without defining the user permission first. Administrators can delegate application 
administration to different users, apply permissions on a per application basis to 
enhance access security and apply permissions to multiple applications 
simultaneously. 

 Named Database Independence. iSynergy provides the ability to configure and 
install the repository as a named database as indicated by the System 
Administrator. This flexibility allows for the deployment of separate iSynergy 
installations to the same database instance. 

iDatix Technology Development Methodology 

The iDatix software design methodology rests upon the concept of producing intuitive software 
products to enable business users to automate their own environment. It is important to 
understand that each user working in business today has the knowledge to make their business 
processes easier and more effective. 

iDatix produces the tools to allow the vision of an employee or an organization to be implemented 
and deployed quickly, without extensive IT dependence. Leveraging the understanding and ideas 
of every employee and using an effective business automation solution is the key to enhancing 
productivity and quality within the business.  

Change must be embraced. Our solutions must provide a simple way for the end user to modify 
and enhance the solution to meet the changing needs of the business. 

Key to this understanding is dividing the automated business solution into its components. 

 What is the critical area of focus?  
 What is the biggest area of need? 
 What is the process today? 
 What are the process gaps and bottlenecks as they are found today? 
 What Documents are used in the process? 
 What Systems/Applications are used in the process? 
 What is the vision of how to automate the process? 
 How can documents, data and users be driven to the same point at each step of the 

process? 
 How it is tied together? 
 How is it deployed? 
 What is the most efficient, cost-way to make it happen? 
 How do we optimize the new solution? 
 How do we expand the utilization and benefit of the system? 
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Client Support Services Contact Information 
Pitney Bowes is committed to providing quality service and support for our customers. If you are 
experiencing difficulty with your iDatix software, please let us hear from you so we can help. You 
may reach us by phone at (877) 250-7939 
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What is Content and Content Management 
In its basic form, content is any type of digital information. It can be text, images, graphics, video, 
sound or documents. In other words, content can be anything that is likely to be managed in an 
electronic format.  

Content Management is a system or the capability to manage and track the location of, and 
relationships among, a firm's content at an element level in a repository. Content Management is 
effectively the management of the content, by combining rules, processes and/or workflows in 
such a way that its’ electronic storage is deemed to be managed rather than unmanaged. Content 
management systems can manage entire binary files (documents), components of files, or 
XML/SGML data. 

 

In other words, content management, simply stated, is the process of sharing information vital to 
an organization in a structured format. In most organizations, unstructured content enters an 
organization's infrastructure from a variety of sources. Regardless of how a piece of content 
enters, it has a lifecycle. 

Revision control. Files can be updated to a newer version or restored to a previous version. 
Changes to files can be traced to individuals for security purposes.  

Indexing, search, and retrieval. For data to be valuable, it must be relevant to the task at hand 
and accessible in a timely fashion. Documents can be parsed for keywords, headings, graphics, 
and other elements; mechanisms for processing search requests become critical. One of the 
greatest benefits of a strong electronic content management system is the ability to get out what 
you put in. By having strong indexing, taxonomy, and repository services, locating the information 
in your system should be simple.  

Scanning. Paper generally enters the organization through a scanner, or sometimes, a 
multifunction device. In centralized scan operations, large volumes of paper are put into the 
system by dedicated workers. In distributed operations, smaller volumes of documents are 
captured with lower volume scanners or multifunction devices closer to their point of creation.  

Document Imaging. Software captures the image of the paper document. Increasingly, 
electronic document images have the same legal status as a paper document.  

Indexing. An essential part of the capture process, creates metadata from scanned documents 
(customer ID number, for example) so the document can be found. Indexing can be based on 
keywords or full-text. 

Repositories. Structured and unstructured-the core of many ECM systems. This is where the 
data resides and where much of a company's investment in ECM resides. A repository can be a 
sophisticated system that costs hundreds of thousands of dollars, or as simple as a file folder 
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system in a smaller company. The key is to have information that can be found once it is placed 
in the system.  

Content Life Cycle. The various phases that content moves through, such as authoring, review, 
management, delivery, and archiving  

Storage. Content needs to "live" somewhere. Storage technology (optical disks, magnetic, tape, 
microfilm, RAID, paper) provide options for storing content online for rapid access or near- or off-
line for content that isn't needed often.  

Rules of thumb for data storage: 

 There are approximately 2,500 pages per drawer in a standard 4 drawer filing cabinet.  
 There are approximately 2,000 pages per linear foot of documents. 
 A standard 8” x 11” paper when stored as a Group 4 is approximately 50k. 
 A standard check image is about 15k. 

Content Integration. Enables disparate content sources to look and act as a single repository.  

Migration. As storage media ages, content must be moved to new media for continued 
accessibility.  

Backup and Recovery. Backing up content in various formats and/or locations helps to ensure 
business viability in the face of a disaster.  

Long-Term Archival. Content that must be preserved over decades must be saved to media, 
such as paper and film-based imaging, with longevity to match.  

Foundational Terminology 
The purpose of this section is to provide foundational terminology and reference material for 
specific concepts contained with this User Manual. 

• Application: In iSynergy, an Application is the digital equivalent to a filing cabinet.  

For example, on a basic level, the Applications created and used within iSynergy to store 
documents are similar to traditional filing cabinets. Examples of filing cabinets, and 
therefore Applications, that are common to many businesses include: Accounting, 
Operations, Insurance, and Human Resources. Typically, employees responsible for 
Insurance documentation store their Documents in a filing cabinet separate from 
employees responsible for tracking Operations. Having separate filing cabinets for the 
two departments is generally advantageous for the efficient storage and retrieval of 
information for each department. It is also sometimes necessary to store particular 
Documents in a separate cabinet for the security or sensitivity of the contained 
information. Within iSynergy, creating separate Applications for different departments 
also proves useful for similar reasons. 

• BIT: A BIT is a binary digit taking a value of either 0 or 1. 

• Byte: In a byte, the information storage measurement is a unit, usually considered to contain 
eight bits. 

• Database: A database is a collection of information organized in such a way that a computer 
program can quickly selected desired pieces of data. 

Note: For the purpose of this document, you can think of a database as an electronic 
filing system. 
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• Document: A Document is any electronic file. In addition to text, Documents often contain 
graphics, charts and other information elements. 

For example, a Document can be a Word document, PDF file, Excel spreadsheet, any 
audio file or a TIFF image. 

• Document Type: Within iSynergy, a Document Type identifies the type of document 
contained within an Application.  

For example, when looking in an Employee folder what documents types would you 
expect to see. Documents common to all employees’ folders might include:  Job 
Description, Time Sheet, Contact information, and Reviews. These commonly 
encountered types of Documents are Document Types. Other examples of Document 
Types include Purchase Orders and Receipts, found in a separate Application (filing 
cabinet) called Accounts Receivable. Notice that different Applications tend to house 
different Document Types.  

• DPI: Dots per Inch is a measure of printing resolution, specifically where the number of 
individual dots of ink a printer or toner can produce within a linear one-inch 2.54 cm space. 
There is one pixel per dot. 

• Pixel: A pixel is a single point in a graphic image. 

• Group 4: Group 4 is a compression method for monochrome bitmaps used by a fax machine. 
Additionally, it is also available as one of the compression options in the TIFF file format. 

• Checkout: The act of locking a document in the repository for editing purposes. Checking a 
document out, locks it and prevents other users from editing the document at the same time. 
This prevents the loss of work as one user must wait until a document is available to be 
checked out before they will be allowed to edit the document. 

For example, if there are two members of an Accounting department working on the 
same invoice, if one of the users has checked out the document to complete some type 
of work, the other user will be unable to checkout the same document. 

• Check-in: The act of adding a new document revision to the repository. Performing a check-
in will add the changed document to the repository and unlock it so that other users will be 
able to see the changes and make further changes to the document. 

For example, if a document has been checked out, it must be checked in. The documents 
will be numbered according to the revision number. Additionally, depending on the 
account functionality management permissions that are granted, the user will have added 
document management capabilities.  

• Index: Within iSynergy, an Index is similar to a label on a traditional folder.  

For example, in the Application example, Documents were stored and retrieved in folders 
according to ‘Employee Name’. ‘Employee Name’ is therefore an example of an Index. 
Indexes help to identify Documents. The storage and retrieval of Documents within 
iSynergy relies on Indexes, much the same as traditional cabinets and folders rely on 
proper labels. 

• System Status: iSynergy maintains a status on all documents in the repository. This status 
tracks whether the document is searchable, deleted or waiting to be indexed or scheduled to 
run in an external application to perform a task. 
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• Document Status: iSynergy provides the ability for the designer to create statuses on 
documents. These statuses can be used to create an ad-hoc workflow or manage document 
status specific to the application being created. 

For example, the status of a Document is its “progress report”. The Status of a Document 
may change as it passes through a business process. Example values for Status include: 
Reviewed, Signed, Accepted or Rejected. These status values can be defined as a UDL 
field. 

• UDL: Within iSynergy, a UDL is a User Defined List. Some Index values may be User 
Defined in that its’ is not unique, but rather chosen from a user defined list. 

For example, a User Defined List limits choices of an Index value during data entry. 
When used properly (a list of eight or less is common), UDLs greatly increase data entry 
efficiency and accuracy. UDLs occur as drop-down menus in the iSynergy interface. 
Index values that are good example candidates for use with a UDL include Document 
Status and Document Type (assuming a limited number of Document Types exists).Very 
poor example candidates for inclusion within an associated UDL include Date and Invoice 
Number, due to the limitless number of possible values. 

• Revisions. A Revision is a representation of a document at a point in time. A document can 
go through many revisions. iSynergy can track the revisions of the documents and maintain a 
history of the document along with, who, what and why the changes were made. 

For example, when a document has been checked in or checked out of the system, each 
action will create a unique document revision number. This number is displayed in both 
the Search results as well as in the Object Table within the repository. 

• OCR: Optical Character Recognition is a type of computer software designed to translate 
images of handwritten or typed text usually captured by a scanner into a machine-editable 
text. 

• Repository: iSynergy can store and manage any Document type for your organization. 

Additionally, the iSynergy Repository is a centralized location in the organization’s 
network that stores all information within the iSynergy system. The iSynergy Repository 
allows for the structured storage, access, management, exchange and protection of 
enterprise information. iSynergy is designed to categorize and archive all forms of 
intellectual property, including multimedia presentations, PowerPoint presentations, 
spreadsheets, marketing literature, word processor Documents, Adobe PDF files and 
sound files such as mp3 and wav. iSynergy can store and manage any Document file 
type you can store on your desktop workstation. 

iSynergy Basic Structure 
There are two basic components to the iSynergy structure, they are: a repository and a database. 
The repository is where the documents are stored and is connected to the database by the 
pointer to source field within the object table. The documents maintain the original file extensions 
within the repository, meaning if the document was a .doc, .pdf, .tif, etc, it would still be in that file 
extension. The pointer to source in the repository is the stored directory location for the content 
and it is stored by a named UNC path. There can be multiple repositories, as the original pointer 
to source entry point never changes. 
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A database is a structured collection of tables that is organized so that its data contents can be 
easily accessed, managed and updated. The database tables contain rows and columns that 
store the data by an index value or metadata. Each table column is an index value, while each 
row within that column is the data for a specific document. A row in the table is represented by a 
sequential item number.  
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Content and Information Flow 
Content lives and exists everywhere either in physical or electronic format. Content that needs to 
be captured and can be done via numerous devices: fax, scanning, drag and drop from the 
desktop, intercepted from a print stream, or electronic capture mechanism. The data is captured 
by key data elements called index values, or metadata. The index values along with the metadata 
reside in the database.  The document resides in the repository. They are linked by the pointer to 
source fields. 
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iSynergy Installation Requirements 
Supported Server Platforms 

• Windows 2003 Server 

• Microsoft SQL Server 2005  

• IIS 6.0. 

Note: It is highly recommended that the server be updated with all the current Microsoft 
service packs, patches and hot fixes for both Server and SQL Server prior to installing 
the iSynergy Database. For more information, please refer to: 
http://msdn.microsoft.com/en-us/sqlserver/bb671254.aspx 

Hardware 

The following table lists the minimum recommended hardware requirements for any server 
running an iSynergy server component: 

Component Minimum Recommended 
Processor Pentium 4, 2.8 GHz Quad Core 
Memory 2 GB 4 GB 
Hard Drive 80 GB, Raid 1 or 5 160 GB, Raid 1 or 5 

SQL Server Configuration 

The SQL Server manages the information repository for iSynergy, and where all of the references 
and statuses exist for tracking the information contained within the system. This makes iSynergy 
very expandable and customizable for the Client.  

The Database is an open architecture to allow third parties and clients to add further 
enhancements and interface with other systems. 

Installation of the iSynergy database on the SQL Server has six main requirements: 

• Windows 2003 Server. 

• Knowledge of the SQL Server SA account password.  

The iSynergy setup program needs administrator privileges to install the iSynergy 
database. 

• Microsoft SQL 2005. 

• Installation of the SQL Server 2005 software has been installed in the environment. 

• .Net Framework Service Pack 2. 

• Knowledge of the desired installation location of the iSynergy Database.  

This decision is based upon network architecture, data redundancy policy and disaster 
recovery policy. 
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Web Server Configuration 

Windows Server 2003 should have all of the IIS 6.0 components required for installation of the 
iSynergy Web services installed by default.  

IIS 6.0 Installation on Web Server 

To confirm that IIS 6.0 is installed on the Web Server, follow these steps: 

1. From the Web Server desktop, select Start>Administrative Tools.  

 

2. Select Internet Information Services (IIS) Manager. 

 

3. From the Root console, drill down to Web Sites>Default Web Site.  
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4. Ensure the following Servers have been installed. 

 Application Server. 
 Document Sever. 
 iSynergy. 
 License Server. 

 

IIS 6.0 Installation on Microsoft Server 2003 

If IIS is not installed on the target Web Server or IIS has been removed from the server, follow the 
below steps to install IIS. 

1. From the Web Server desktop, click Start>Control Panel. 

2. Select Add or Remove Programs. 
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3. Select Add/Remove Windows Components. 

 

4. Select the Application Server. 

 

5. Click Details and verify WWW, FTP and SMTP are enabled. 
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6. Verify Internet Information Services (IIS) is installed. 

 

7. Click OK. 
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Customize iSynergy Option 
iDatix has provided an additional option to customize the look of iSynergy. Upon purchasing the 
product out of the box, by default you are provided with an orange skin. However, should you 
wish to customize the look of the iSynergy solution, follow the below instructions. 

Note: This section assumes you have already installed the product. 

1. Launch a Windows Explorer window. 

2. Navigate to C:\Program Files\iDatix\iSynergy. 

 

3. Navigate to and select the web.config file. 
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Note: Notepad opens the web.config file. 

4. Within the web.config Notepad document, search for <Pages theme = “site”>. 

 

5. Change the “Site” to the site name of the new theme. 
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Note: An additional theme is delivered with iSynergy, to use this theme change the site to 
‘blue.’ When creating a new site css set, you will need to create a CSS for IE 6 and 7. 
Name the IE 7 CSS directory as the theme name and place it in the Program 
Files\iDatix\iSynergy App_Themes directory. To support IE 6, create the CSS directory as 
name 6. Be sure to keep the name of the Css files as site.css 

6. Select File>Save. 

Note: By selecting File>Save, you do not have to manually restart IIS because this save 
action will automatically restart IIS and launch the application for you. Additionally, if you 
are using IE 7, no additional skin changes are required. However, if you are using IE 6 
iSynergy will automatically append the file a’.6’ to the theme name that has been 
detected. 

iSynergy Login 
Accessing iSynergy is as simple as starting your Internet browser, entering the iSynergy URL and 
logging in. 

1. Start your Internet Explorer browser and enter the appropriate Web address for the 
iSynergy system in the address field. 

Note: After an install, Internet Explorer should automatically launch the log in dialog, 
however, if this does not happen, contact your System Administrator if you are not sure 
what to enter in the address field. Additionally, it is important to note iDatix does not 
support Mozilla Firefox internet browsers, only Internet Explorer.  

2. Click Go or press Enter.  

3. At the Login screen, type in your Login ID and Password 

4. Select Login. 

 

Note: If the login is unsuccessful, iSynergy displays an error message and the cursor 
returns to the Login ID field. Retry the login and make sure to check your keyboard’s 
capital lock key indicator. Remember: Passwords are case sensitive! 

5. A successful Login displays the default view of the Search page.  

Note: The Document Pane is initially empty and remains as such until a completion of a 
search. 
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6. To log out of the iSynergy program, simply select Logout on the Search page. 

 

Note: By design, iSynergy automatically logs out a user when the program has been 
inactive for 30 minutes. If you want to change the default System Options, navigate to 
Admin>System Options>Login Timeout>Edit. Upon re-activation, iSynergy returns the 
user to the Login dialog box. To continue working with the program, the user must 
reestablish their login by entering their login ID and password combination again.  

Understanding iSynergy  
iSynergy provides a completely automated paperless business solution for any business, 
department or enterprise. It is capable of starting at the departmental level and expanding to meet 
the needs of a global enterprise. iSynergy saves millions by making a dramatic impact on all 
business processes, improving productivity, quality, compliance and security while reducing the 
costs of filing, storage, distribution, shipping and other labor associated with document 
processes. 

iSynergy Server is the heart of the iSynergy suite of products. iSynergy Server is a Web Server 
application that provides the main browser-based user interface for all users who want to search, 
retrieve, view, fax, print, email, or apply annotations to the documents contained in the iSynergy 
repository. It also contains the administration component where system administrators can add 
and manage users, build user and group security, and create new iSynergy applications.  The 
iSynergy Server is sold as part of the concurrent user licenses and is included with all base user 
sales. 

iSynergy Server also provides basic Ad-Hoc Workflow for business process automation and 
reporting.  All documents stored in iSynergy maintain a complete Audit Trail for compliance 
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purposes. iSynergy’s complete, modular approach provides a scalable solution that can meet the 
demands of the users with the most complex data issues and highest document volumes.  With 
iSynergy’s intuitive user interface, users find any document quickly and easily. Our users have 
enjoyed dramatic ROI’s from labor reduction and productivity improvement almost immediately 
after implementation. 

iSynergy captures documents from virtually any source, automatically indexes them using 
recognition technology and/or data from third-party applications. All modules of iSynergy are 
integrated ensuring compatibility and success in storage and retrieval functions combined with 
workflow and integration to key line-of-business applications. This complete integration makes 
iSynergy easy to use and maintain and provides the ability to expand iSynergy into other 
departments and business units. The iSynergy Solution is completely scalable to meet the 
requirements of both small and large organizations. 

The iSynergy suite of products is comprised of a variety of modules each with a specific function 
and purpose to create a fully automated paperless enterprise. Because all modules have been 
developed by iDatix, they are seamlessly integrated with each other. These iSynergy modules 
provide the ability for creation of a very specific and customized solution to satisfy any business 
need, requirement or process. The overall functionality of iSynergy can be illustrated by the 
following diagram: 

 

Application Pane  

iSynergy is browser-based, making use of familiar and intuitive browser controls. If you can 
browse the Internet, you can work in the iSynergy interface. The iSynergy User interface has two 
primary viewing panes: the Application Pane and the Document Viewer Pane. 
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By default, the Application Pane loads the Search page following a successful login. The 
Application Pane varies in content and functionality depending on the current task the User is 
performing as well as permissions granted to that User.  

For example, only certain Users with granted permissions are able to access the 
functions available on the Admin or Indexing pages. For a complete understanding of 
iSynergy Permissions, please review the Permissions section of this manual. 

Pages displayed within the Application Pane (dependent on functionality and permissions) 
include: 

• Search page. 

• Workflow page. 

• Indexing page. 

• Routing page. 

• Admin page. 

• Tools page. 

Examples of functions performed within the Application Pane and its’ associated pages include: 

• Query for Documents.  

• Build and maintain electronic filing Applications through user and group permissions. 

• Set permissions controlling access to data. 

• Index Documents. 

• Route Documents. 

• Print individual or multiple exported Documents. 

• Email individual or multiple exported Documents. 

The Application pane provides the ability to view with the documents. There are four Selection 
Columns. 

• Select All Documents. 

• View File Column. 

• Edit Index Column. 
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• Add Notes Column. 

 

Element Description 

Select 
Documents 
Column 

Use this column to select one or more Documents for further processing 
such as exporting, emailing, and printing. To select Documents individually, 
mark the appropriate checkboxes. To select all the Documents displayed on 
the current page, mark the checkbox on the far left of blue header row.  

Note: Marking the Select All results checkbox at the bottom of the 
Results Table will select all Documents on all pages of the results. 

 

View File Column Selecting a File icon from the View File Column loads the first page of the 
selected Document into the Document Pane, as well as highlights the row of 
the selected Document in blue. 

 

Note: If you are viewing the Results table in full screen mode, the 
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selected Document loads in a new modal dialog window. 

Edit Index 
Column 

Clicking the Edit icon of the appropriate Document displays the Edit Index 
page. 

 

Note: From the Edit Index page, a User can update Index values, 
perform a soft delete, or route the Document. 

Add Notes 
Column 

Selecting the Add Notes icon of the appropriate Document loads the Notes 
page of the selected Document.  

 

Note: Multiple notes entered on the Notes page appear sequentially 
with a stamp that indicates the date, time, and user that entered 
each note. 

Index Value Columns 
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The Index Value columns display the Index values for Documents returned from a search query.  
The Column Header represents the Index Name, which are hyperlinks. Clicking an Index value in 
the Results table begins a Cross Query search for the selected value.  

Sort Order 

By default, the sort order for the first three Index Value columns (left to right) is ascending. Values 
in the first Index Value Column receive primary sort preference, while values contained in the 
second and third Index Value Columns are sorted sequentially. This sequential sort order results 
in the alphabetical grouping of similar Names followed by subsequent sorting of Doc Type, 
followed by sorting of Status . 

Modifying Sort Order 

Index value column headers (Index Names) serve as hyperlinks for sort order functionality. 
Clicking on an Index Name once will sort the contained values in an ascending order. Double-
clicking an Index Name will sort column values in a descending order. Clicking the Index Name a 
third time removes sort order or, if the Index Value column is one of the first three columns in the 
table, the default sort order of the column is restored.  

The column(s) selected for sorting, as well as each one’s sort order, are displayed at the top of 
the Results table. 

Sequential sort orders provide a cascading filter effect in the presentation of the table data. 

Row Color Indication 

There are three row colors to provide Simple to Discover Results. 

 

Element Description 

Blue A blue row indicates the active row. 

Yellow The yellow rows alternate with the gray rows to distinguish between 
adjacent non-active rows. 
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Gray The gray rows alternate with the yellow rows to help distinguish non-
active rows. 

History 

Selecting History displays a listing all of the changes made to the selected Document(s).  

 

Access to History functionality is permissions based by using the System Reporting>System 
Management . 

Items tracked by History include:  

• The creation of the Document 

• Subsequent modifications 

• Index updates  

• Status changes  
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Document Viewer Pane  

Within the Document Viewer Pane a user is able to view and manipulate documents. Examples of 
functions performed within the Document Pane include: 

• Zoom in and zoom out on Document images. 

• Rotate Documents. 

• Document Navigation. 

• Locally Print individual or multiple pages of Documents. 

• Scan Documents to append to current document in the Viewer. 

• Locally Email particular pages of a Document or the entire Document. 

• Make annotations on Documents. 

• The Document Pane contains the Top Toolbar, the Document image, the Bottom Toolbar 
with thumbnail/book view options, and the Page Scroll. 

• The Document Pane Toolbars provide access to the functionality of the Document Pane.  

• The toolbars become active once an image is loaded.  

• Note: Many tools are permission specific and may not be seen by all users. 

Top Toolbar 

This toolbar is located at the top of the Document Pane.  

 

The following table gives a brief description for the function of each icon on the top toolbar. 
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Element Description 

Save A Copy 

 

Saves changes made to the Document. 

Print 

 

Prints or faxes Document selections using local drivers. 

Scan 

 

Initiates the Scan component of iSynergy per the appropriate license you 
have been assigned. This option is used to append the document 
currently in the viewer.  

Email 

 

Used to email the complete Document or individual pages. 

Settings 

 

Used to set user preferences for Printing or Emailing, as well as the PDF 
Viewer control settings. 

Zoom In 

 

Zoom in or out on a viewing selection 

Zoom Out 

 

iSynergy remembers the zoom power setting between Documents 

Best Fit 

 

Best Fit expands or contracts the image in the View Frame allowing the 
entire image to display 

Fit to Width 

 

Fit to Width expands or contracts the image in the View Frame allowing 
the entire width of the Document to display 

Rotate Left 

 

Rotates the Document selection left in 90-degree increments 

Rotate Right 

 

Rotates the Document selection right in 90-degree increments 
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Find 

 

Used to search for specific text within a Document. 

FullText 

 

Displays the content of words found in the OCR process 

Hide Annotations 

 

Used to hide annotations on the Document. 

Pan 

 

Used to navigate across the surface of a zoomed in Document. 

Select Annotation 

 

Used to select annotations or redactions. 

Insert Annotation 

 

Used to insert an annotation. 

Insert Redaction 

 

Used to conceal sensitive information. This can be done with any color 
with black being the default. 

Insert Highlight 

 

Used to highlight information on the Document. 

Insert Rubber 
Stamp 

 

Used to Insert a Rubber Stamp. Default options are: 

Denied 

Received  

Approved 

Insert Line 

 

Draw lines 

Pointer 

 

Create a line with an arrow 
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Freehand 

 

Draw lines freehand. 

Rectangle 

 

Create a Rectangle 

Ellipse 

 

Create an Ellipse 

Text 

 

Create a text box 

Foreground Color 

 

Change the background color of the annotation box 

Drop-down menu 
list 

 

Select to see items on the list 

Line Thickness 

 

Change the thickness of the lines 

Redactions 

Redactions provide the ability to conceal sensitive information on a Document. 

To insert a redaction, follow these steps: 

1. Click the Redaction icon. 

 

2. Drag-select over the information you wish to conceal. 

3. Release the mouse. 
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Highlights 

The Insert Highlight function enables Users to emphasize important information in a Document by 
drag-selecting an area to appear in a highlighted box. 

To insert a highlighted region, follow these steps:  

1. Select Insert Highlight. 

 

2. Left-click the mouse and drag a box over the area you wish to have highlighted. 

3. The color of the Highlight can be modified, by following the same procedure applied to editing 
an Annotation. 

Rubber Stamp 

The Rubber Stamp function gives granted Users the ability to indicate approval, denial, or other 
endorsements onto a Document by affixing a digital “rubber stamp” impression. The use and 
modification of rubber stamps is permission based. 

To insert a rubber stamp, follow these steps: 

1. Select Rubber Stamp. 

 

Note: By default, there are three stamps to choose from: Denied, Received, or Approved.  

2. Select a Rubber Stamp from the list and drop it on the Document. 

 

Note: Right-click on the rubber stamp to cut, copy, or delete it. 
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Hide Annotations 

The Hide Annotations function allows users to view an annotated Document without the 
annotations displayed. Selecting the Hide Annotations tool masks, but does not remove, the 
annotations from the Document. 

To hide annotations, follow this step: 

1. Select Hide Annotations. 

 

2. Once the Hide Annotations icon is selected, annotations do not display on the Document. 

Pan 

The Pan function works in conjunction with the zoom feature, allowing you to navigate within a 
Document once it has been magnified.  

To pan a Document, follow these steps: 

1. Right-click anywhere on the toolbar to activate the drop-down menu listing toolbar options.  

2. Click the Zoom option to magnify the Document.  

 

Note: The zoom tool may also be selected to accomplish this goal. 

3. Select the Pan option. 

 

4. Left-click and hold the mouse button to grab and move the page. 

Save a Copy 

The Save a Copy tool allows Users to save an electronic copy of a Document from within 
iSynergy to a user-specified location on a workstation or network. 

To save a copy of a Document, follow these steps: 
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1. Select Save a Copy.  

 

Note: This will activate the Save Options dialog window. 

2. Select the desired Page Range and saving inclusion options, and page format settings in the 
Save Options dialog window. 

 

3. Click OK. 

4. Browse to the desired location to save the file, type a name for the file in the File Name filed, 
and then click Save. 

5. A copy of the Document is saved to the specified directory. 
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Print 

The Print function allows Users to print a hard copy of Document(s) from within the iSynergy 
application. 

To print a Document, follow these steps: 

1. Select Print 

 

Note: The Print dialog window displays. 

2. Selecting the desired printer and other print options,  

3. Click OK. 

 

Email 

The Email function allows Users to send an electronic version of Document(s) from within the 
iSynergy application to a recipient via email. 

To email a Document, follow these steps: 

1. Select Email. 
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Note: This Email dialog displays. 

2. Select the desired Page Range and emailing inclusion options in the Email pop-up box. 

3. Click OK. 

 

4. Enter the recipient email address in the To field.  The Subject line may be changed and 
additional text entered in the message area. 

5. Click Send when the message is complete. This will email the Document(s). 

Settings 

The Settings function allows Users to choose printing and emailing options for Documents within 
iSynergy. 

To view and modify settings, follow these steps: 

1. Select Settings.  
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Note: The Settings dialog window displays. 

2. Select the desired options from the General, Printing and Emailing tabs. 

 

3. Click OK. 

Bottom Toolbar 

This bottom toolbar contains the thumbnail/book view and the page scroll and displays each time 
the Document Pane displays. 

 

Element Description 

First Page 

 

Navigates to the first page 

Previous Page 

 

Navigates to the previous page 

Next Page 

 

Navigates to the next page 
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Last Page 

 

Navigates to the last page 

Page Counter 

 

Identifies the current page in the Document  

If a page number is entered in this region, the viewer will go to the page 
number entered. 

One Page View 

 

Sets the viewer to a single page view 

Thumbnail View 

 

Sets the viewer to a thumbnail view 

Thumbnail and 
Page View 

 

Splits the viewer into a thumbnail preview pane and single page view 
pane 

Book View 

 

Allows for two pages to be displayed on the screen either horizontally or 
vertically 

Top and Bottom 
View 

 

Displays the upper and lower portions of the Document 

Scroll Bar 

 
Allows scrolling through all pages of the Document 

FullText Buttons 

The FullText buttons are located within the Top Toolbar of the Document Pane. These buttons 
only display following initiation of a FullText search, otherwise they are absent from the top 
toolbar. 

Element Description 

Find Used to search for specific text within a Document 
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Element Description 

 

FullText 

 

Displays the content of words found in the OCR process 

Hide Highlights 

 

Removes highlighting from words identified in the search 

Previous 
Highlighted Word 

 

Navigates to the previous highlighted word 

Next Highlighted 
Word 

 

Advances to the next highlighted word 

 
The first time the Document Pane loads, (prior to a search) it contains no Document and is 
empty. To display a Document in the Document Pane, follow these steps: 

1. Select an Application. 

2. Select Search. 

 

This submits an unspecific search that will return all files in the selected Application to the Results 
page. The Results page contains a Results table that lists the Indexed Documents. By default the 
Document Pane displays the first Document listed in the Results table. 

Scanning 
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Scanning is the process of converting paper Documents into electronic formatted Documents. 
When converted, an electronic Document becomes an image file with the extension TIFF 
(Tagged Image File Format). This process of converting paper Documents to digital Documents 
typically uses high performance, production-oriented scanners that can process from 15-200+ 
pages per minute. iSynergy can route, store and manage converted TIFF Documents. 

Print  

The Print option prints all selected Documents shown on the Results page. Documents selected 
to print are sent to printers defined on the iSynergy web server. 

 

Toggle Full Screen 

This option toggles the Results page to a full screen allowing tables with large amounts of data to 
be viewed more easily.  

Clicking on this option when the arrow points to the left returns the view of the Results page to 
standard size. 

 

 

Note: For a complete understanding of iSynergy’s search capabilities, please refer to the 
Searching for Documents section of this manual. 
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Application Management 
An Application in iSynergy is the virtual equivalent of a traditional physical filing cabinet or 
shelving system. These filling cabinets are analogous to the filing cabinets within the major 
divisions in your company. Whether you store your documents in a filing cabinet or electronically 
in iSynergy, the indexing and search retrieval are conceptually the same  

For example, Accounting, Operations, Insurance and Human Resources all have a filing 
cabinet where they keep documents important to their department. People in the 
Insurance department do not file their documents in the same cabinet as Human 
Resource department. 

 

An iSynergy application can be used as a simple archive for documents post processing and is 
most often the starting point for application implementations. Starting with a back-file conversion 
project is a good way to develop experience and a comfort level with the new solution, but does 
not provide the greatest benefits to the business. Moving the capture processes to the front-end 
instead of the back-end leverages the benefits of document management and provides the 
capabilities for true process automation. 

By capturing documents and content at the front of a business process at the time of receipt, you 
eliminate many labor-intensive activities and instantly eliminate risks such as lost documents as 
you perform the tasks that make up your work process. You enhance information access, process 
tracking, process flexibility, compliance, quality and overall throughput. This is because 
documents and content are routed through the process electronically without the need for 
handling and moving physical files, making copies or being limited to a linier process. 

The Application structure in iSynergy is configurable to comply with all the organizational needs of 
the enterprise, which makes managing Applications in iSynergy straightforward and simple. To 
realize the full potential of iSynergy’s storage and retrieval functionality, careful thought and 
planning must be given to the development of your Applications.  

Note: Please review iDatix sample Best Practices Application Configuration worksheet in 
Appendix A and/or the iDatix Configuration Guide for further details.  

In following sections, we will examine the different elements of an iSynergy Application structure 
in detail and describe how to construct an effective application. 
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Index Fields 
An Application foundational element is the Index field, which is used to assign identifying 
characteristics, or index values, to a Document stored in the iSynergy Repository.  

 

Note: An index value is a data value in the iSynergy repository that helps to identify a 
Document within iSynergy. Additionally, index fields are entry fields to assign values for 
indexes and must comply with database standards. To help insure standards are met, 
Index values are assigned specific attributes known as Index types. 

iSynergy relies on indexes to file Documents correctly. These indexes correlate to labels on a file 
folder. When first creating an iSynergy application, the indexes you choose should be the same 
as the filing procedure in the office. 

Note: iDatix Client Support Services recommends the following core index values for an 
iSynergy Application: 

 ID Number. 
 Name. 
 Date. 
 Document Type. 
 Status. 

Each of these generic indexes can be translated to an industry, department or application specific 
term.  

Note: It is important when communicating with the potential users of the new iSynergy 
Application to use the specific term and not the generic term. This provides the user with 
the context necessary for them to identify with the application and to gain a quick 
understanding of how it applies to their own personal job function. 

User-Assigned Index Fields 

The System Administrator defines User-Assigned Index Fields for each Application. These Index 
fields vary with each unique iSynergy Application. 
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Note: For example, the Checks Application may have a unique Index field, such as 
Purchase Order, while Human Resources may have a unique Index field for Social 
Security Number. User-Assigned Index Fields are used primarily to search and retrieve 
Documents from the iSynergy repository. 

System Assigned Index Fields 

By design, each iSynergy Application has System-Assigned Index fields. These index fields 
contain values used by the iSynergy Repository to track events and changes in the status of 
objects stored in iSynergy.  

 

Note: Report generation and various system administration tasks make use of these 
values.  

The following table lists the System Assigned Index Field names and descriptions:  
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Element Description 

Pages Provides the ability to search within a range by the number of pages 
contained in the submitted document. 

 

CreatedBy Provides the ability to search by the name of the user who originally 
submitted the Document to iSynergy. 

 

CreateDate Provides the ability to search by the date within a range that the 
Document was originally submitted to iSynergy. 

 

ModifiedBy Provides the ability to search by the user who made the most recent 
modification to a submitted Document. 

 

ModifiedDate Provides the ability to search within a range by the date the Document 
was most recently modified. 

 

BatchID Provides the ability to search within a user defined range for a 
document’s identification number. When utilizing any of the iDatix 
capture products, a unique batch ID is created and associated with the 
Document.  
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Note: Each document that is submitted to iSynergy receives a 
unique batch ID. The object ID in the repository denotes the 
object, where as the batch ID denotes the Documents that are 
submitted. 

Object Status Provides the ability to choose a search the status of an object within 
iSynergy from a drop down menu. 

  

Hard Coded Object Status Codes 

• E: Searchable Documents (Display in the result set for a 
search in the system). 

• P: Manual Indexing (Display in the Manual Indexing 
screen for user intervention). 

• I: Routed to Inbox (Documents routed to an individuals 
or groups inbox). 

• X: Deleted (Documents that have been soft deleted). 

• C: Corrupt (Documents that have been determined to be 
corrupt or of incorrect resolution). 

• Y: Source Copy (Large multi-page TIFF files that have 
been separated into smaller sections are retained). 

Checked Out by 
User 

Provides the ability to search for a document by choosing a user from the 
drop down menu. 
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Note: The Checked Out by User field is only displayed if at the 
application level, Revision control settings are selected.  

Records Per Page Provides the ability to define the number of displayed records per page. 

 

Index Field Formats 

Index Fields allow you to enter values for a search. There are three types of index field formats:  

 Standard. 

 Drop Down Menu (UDL’s). 

 Range (Numbers and Dates). 
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To use a standard index field, simply type in the appropriate information. 

 

The drop-down menu allows you to choose a single index value. Simply, select the drop down 
arrow and choose an index value from list.  

 

Additionally, to select more than one value from a drop-down field: 

1. Select the Plus Icon. 

 

Note: A pane for the selected index type displays the available index values. 

2. On your keyboard, select the Ctrl key and choose the appropriate Multiple Indexes. 
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3. Select Continue. 

 

The range field format applies to query strings composed of numbers or dates. To use a range 
field, enter two numbers that represent a range of numbers or dates within which you wish to 
search.  

Note: Unless otherwise indicated by your System Administrator, the Date Range must be 
in the following format: mm/dd/yyyy. 

 

Note: You are required to specify a full range with a range query. However, to search on 
a specific number or date, fill in only the first field and leave the second field empty. 

Display Fields 

The Display Fields functionality allows a user to modify the displayed Index fields on the currently 
selected Application Search page, as well as the Results page.  

Note: Display Fields settings are Application specific, as well as specific to the logged in 
user.  

To modify which fields display on both the Search page and Results page for the current 
Application, follow these steps: 
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1. Select Display Fields. 

 

Note: The Selected Indexes dialog displays. 

2. Only Check the Index Fields you want to display. 

 

3. Select Update. 

4. The current Application now displays only the Index fields selected.  

Clear Fields 

This option provides a simple way to remove all search criteria previously entered by the user. 
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1. Select Clear Fields. 

 

2. The data contained in each respective index field is removed. 
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Index Types 
An Index type is composed of a set of attributes that allows storage of values or records, in a 
database that comply with ODBC standards. Index Types are user defined and provide the ability 
to restrict the type of data that can be added for a particular type of field. Furthermore, formatting 
and masking can be set when defining the index types.  

For example, you can use the Zip index Type or the Zip + 4 Index Type to standardize 
the way a user inputs the zip code for the business process. 

 

By design, iSynergy contains pre-defined index types such as address line, company name, first 
name and social security number, as well as many others. These Index Types are designed to 
simplify your application definition process. 

To view, edit and delete an iSynergy Index Types follow the below steps. 

1.  Navigate to the iSynergy Menu Bar. 

2. Select Admin>Index Types. 

 

Note: The Index Type dialog window displays. 

3. Select Add Type. 

 

Note: The Add Index Type dialog window displays. 

4. Define the Index Type Name. 
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5. Navigate to Data Type and select the Drop Down Menu. 

 

Element Description 

Boolean Provides the ability to define an index data type where the values are 
either True or False. 

DateTime Provides the ability choose an index data type where the values are 
defined with a date and time. 

Decimal Provides the ability to choose an index data type where the values are 
defined by a floating numeric value point. 

Numeric Provides the ability to choose an index data type where the value is a 
numeric integer. 

Text Provides the ability to choose an index data type where the values can 
be either characters or numeric integer. 

6. Tab to the Length text field and define the character length. 
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Note: The Length text field denotes the maximum length of characters and spaces an 
Index Value can hold For example, if the Data Type is Text, the Length might be 25.  

7. Tab to the Mask text field and define the mask. 

 

Note: A Mask is a filter that selectively includes or excludes certain values. For example, 
when defining a database field, it is possible to assign a mask that indicates what sort of 
value the field should hold. Values that do not conform to the mask may not be entered. 

8. Tab to the Format text field and define the format. 
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Note: The format text field provides additional control and functionality to index types. For 
example, if you use the DateTime Index type, you can specify United States style display 
(mm/dd/yyyy) or European style display (dd/mm/yyyy). 

9. Select Create. 

 

Note: An Index Type has been created and will be available for the use within an 
Application. 

Editing and Deleting an Index Type  

To edit an index type, follow the below steps: 

1. On the iSynergy Menu bar, select Admin>Index Types.  

Note: The Index Types dialog window displays. 

2. Navigate to the far left column and select Edit. 

 

3. Navigate to the Appropriate Index Value and make the appropriate changes.  

 

4. Select Update. 



iSynergy 3.9.3 SBS Advanced User Manual   Page 56 of 186 

 

Note: Selecting Cancel will not save your changes. 

5. The Index Type has now been modified and updated in the Repository. 

To delete an index type, follow the below steps: 

1. On the iSynergy Menu bar, select Admin>Index Types.  

Note: The Index Types dialog window displays. 

2. Navigate to the far left column and select Delete. 

 

Note: A Windows Internet Explorer dialog window displays confirming you want to delete 
the selected index type. 

3. Select OK. 

 

Note: Select Cancel to close the Windows Internet Explorer dialog window and keep the 
index type. 

4. The index type is removed from the Index Type dialog. 

User Defined Lists (UDL) 
iSynergy utilizes both Index Fields and UDLs.  

The UDL is displayed in a drop down menu that is created by the administrator when setting up 
the iSynergy Application. An Index Field is an object that accepts an index value entry. iSynergy 
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UDL’s accept index values in the form of a list. Each list as defined by the user, contains common 
items that can be used across multiple applications or is specific to a singular application.  

UDLs provide the ability to improve Document search accuracy while simultaneously minimizing 
data entry errors. 

For example, you may have a status type UDL which contains generic document types 
for process. The HR Application might have a Pending, In Process, Complete and 
Cancelled UDL. 

To simplify the workplace, if you can reuse the aforementioned status in the Invoices 
Application you might have an application– you are in effect utilizing one UDL that will 
further drive the ad-hoc workflow ability within iSynergy.  

 

UDLs are defined and available for viewing, by navigating to the iSynergy Menu Bar and selecting 
Admin>User Defined List.  

 

Note: A UDL is automatically included in the default list of Index types and is assigned a 
data type of Select. All UDL columns contain a Null selection, which is a system-assigned 
Index value. If an Index field is not a required field and if left empty by the user, the 
Document will be assigned a Null Index value. 
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Furthermore, UDLs are static lists that cannot be added to by the end user while indexing a 
document.  

Note: Index types that are contained in a UDL list from an implemented Application 
should not be deleted or changed because you could potentially disrupt a workflow; 
however, you can add a new UDL field value to an existing UDL. 

Create a UDL 

To create a UDL, follow the below steps: 

1. On the iSynergy Menu bar, navigate to Admin>User Defined Lists.  

2. Navigate to the Add List text field. 

3. Name the UDL.  

 

4. Select Add List. 

 

Note: Do not use special characters when creating an application in the UDL. These 
include: !  $  %  ^  &  *  (  ) +  :  ;  '  <  >  .  ,  ?  /  {  }  [  ]  |  \  ~  `  " – Certain special 
characters could unexpectedly cause an unwanted mass update in the database table 
due to a known MS SQL Flaw called SQL injection. If you would like additional 
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information, please contact iDatix Client Support services and/or review the following web 
site. http://support.microsoft.com/kb/954476 

5. The name of the UDL displays in the User Defined List dialog.  

 

Add a List item to a UDL 

To add one or more list item to a UDL, follow these steps: 

1. On the iSynergy Menu bar, select Admin>User Defined Lists.  

2. Navigate to the UDL you want to modify.  

Note: The User Defined List dialog displays. 

3. Navigate to the Add Item text field and enter the name of the Index value to be displayed. 

 

4. Click Add Item. 

 

Note: The defined List Value is placed in the UDL pane. 
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5. Repeat steps 3 and 4 until all list items have been added to the UDL. 

 

Note: To rearrange the list items, select either Move Up, Move Down or Sort Ascending.  

6. Select Update. 

 

Note: To cancel the UDL list, select Cancel. Additionally, to delete the entire UDL list, 
select Delete List. 
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Delete an Item on a UDL 

iDatix best practice does not recommend deleting a UDL item in an implemented Application 
because you could potentially disrupt a workflow and cause database orphans.  

This will result in a system generated error; however, if you choose to delete an item on a UDL, 
follow the below steps: 

1. On the iSynergy Menu bar, navigate to Admin>User Defined Lists.  

2. Navigate to the UDL you want to delete.  

Note: The User Defined Lists Modification dialog displays. 

3. Select the item in the list you want to delete. 

4. Click Delete. 

 

5. You have now deleted an item in the UDL. 

Delete an Entire User Defined List 

As aforementioned, once you have created, implemented and began using an application, it is 
important to remember that you should not delete a UDL list item. If an index value contained in 
the UDL has been used in any record in the application, deleting an index in the list and/or the 
complete UDL may cause database orphans. Meaning, if a user accesses the document, 
iSynergy searches for its’ index value and if the UDL no longer has the list item, iSynergy will be 
confused as to what the item is and execute a system error.  

For example, if a document has an index value from a UDL of ‘Maid in America’ and later 
the UDL is corrected to show ‘Made in America’, the document can no longer find the 
original entry and will generate an error. The way to avoid this is to have someone update 
all database tables that reference the changed or deleted item. The table needs the same 
entry as the document to prevent the error. If there is no DBA on hand to make the 
changes, it is advisable to not alter the existing USL items. You can add to the list, but 
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not delete or edit. For additional help, please contact the iDatix Client Support Services 
department. 

To remove an entire UDL, follow these steps: 

1. On the iSynergy Menu bar, select Admin>User Defined Lists.  

2. Navigate to the UDL you want to delete.  

3. Select Delete List. 

 

Note: A Windows Internet Explorer dialog window displays. Ensure that you read the 
error message as some applications maybe utilizing the UDL you are deleting. 

4. Select OK. 

 

Creating an Application 
Once you have thoughtfully planned the structure and function of your Application, it is easy to 
create and implement your Application in iSynergy. Proper analysis and planning combine to 
ensure effective implementation of Application(s) that meet or exceed intended goals for use. 

The standard Application definition requires a minimal set of defined parameters to accomplish 
the definition process. The fundamental parameters are the index values that will be used to 
access, search, secure and manage the stored documents. This is also called the meta data.  
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iSynergy allows for a practically unlimited number of index values per iSynergy Application 
(Virtual Filing Cabinet). Each index can be completely customized to meet the need of the 
documents and processes being automated. Again, the core index values are: 

 ID Number 
 Name 
 Date 
 Document Type 
 Document Status 

You will find that there is a common theme when defining indexes for iSynergy. You just have to 
ask yourself what am I looking for and how do I want to be able to find it. If you think about most 
filing solutions they are organized by a number in numerical order or by a name in alphabetical 
order. In the real paper-base environment, if you wanted to store a document by both methods, 
you would have to copy the document and store it in two different files. iSynergy allows you to do 
this without the need to make a copy and without the labor to manage two different filing systems. 
You simply name both items as index values in the Application definition and the document can 
be retrieved by searching using either value. 

iSynergy uses a simple status value to represent where work is in the process. The Status values 
are defined as a User Defined List (UDL) of possible work steps or process tracking values such 
as: Pending, Waiting for Approval, Approved, Denied and Completed. 

Note: For more information, please review the UDL section of this manual. 

As work is captured into the iSynergy Solution the status value is set to pending to initiate the 
workflow process. Each worker may execute a search in iSynergy to find work that needs to be 
completed in a given status and then save the query; thus simplifying the search process and 
automating the method of getting work by the user. 

 

Often it in necessary to assign work to a specific user or team. This can be done by creating an 
Assign To index value to help drive the ad-hoc process. Used with the Status index values you 
can control the flow of documents and content through the defined business process to specific 
user or team. Thus, the user of iSynergy can send work to the accounting manager for approval. 
After approval, the accounting manager can send the work to the payment department for 
payment or back to the submitter for additional information. 

Ad-Hoc workflow is a user driven process and is dependent on the user’s ability to correctly 
assign the index values at the end of their task to have the work move to the next task in the 
process. There is no process enforcement. There are also no business rules. Ad-Hoc workflow 
does not provide functionality for “if”. If would imply asking and processing a question and that is 
a business rule. Such as, “If the amount is greater than $1000 then send it for approval”. Ad-Hoc 
workflow is driven by user knowledge and action and does not process or enforce rules. 
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Basic Ad-Hoc workflow is included with the base iSynergy product suite. Progression can enforce 
business rules and processes and gives the user the ability to use a graphical tool to design a 
business process application without the need for programming. 

Note: For further example and documentation on workflow status, please review the 
Progression Advanced User Manual. 

Below is a quick reference for creating an application.  

Note: For the complete application checklist, please review Appendix 1. 

When creating an Application, it is highly recommended that you follow these steps. 

1. Create new Index types (if required). 

Note: iDatix best practice for index values are no more than five; however, this will vary 
slightly up or down based on the needs of the end user and the particular process. 

2. Create UDLs. 

3. Create the Application. 

4. Add Indexes to Application. 

5. Select Implement. 

Create a new Application 

To create a new Application in iSynergy, follow the below steps: 

Note: The following instructions assume that Index Type(s) and UDL(s) have been 
successfully created. If not, instructions on creating Index Types and UDLs are discussed 
previously in this Manual. 

1. On the iSynergy Menu bar, navigate to Admin>Applications.  

 

Note: The Application dialog window displays.  

2. Select Add New Application. 
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Note: The Add Application dialog window displays. 

3. Enter the Application name. 

 

Note: If applicable, tab to the Description Pane and define a description for the named 
Application. Additionally, if you want the Application to have Document level security 
and/or be excluded from Global searching, select the appropriate checkbox. Finally, by 
default, all newly created Applications are assigned the P status. For more information 
regarding iSynergy status, please review Appendix 2 – iSynergy Statuses. 

4. Select Create. 

 

Note: If an Application is implemented, the Implemented column on the Application 
Configuration is listed as True. If the Application is de-implemented, the column value is 
listed as False. 

5. You have now created an Application and you can begin adding indexes. 

Deleting an Application 

To delete an application, follow the below procedure. 

Note: When you delete an entire Application, the associated work items and documents 
are also deleted. 

1. Navigate to Admin>Application. 



iSynergy 3.9.3 SBS Advanced User Manual   Page 66 of 186 

2. Select the Application you want to delete. 

Note: The Edit Application dialog displays. 

3. Select De-implement. 

 

4. Select Delete. 

 

Enabling Revision Control 

Revision Control provides the capability to retain a history of older versions of documents. The 
revision control feature can be configured for specific application cabinets and at several degrees 
of retention.  
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Revision control provides the ability to manage multiple revisions of a document. iSynergy offers 
this robust functionality so that you may simply your workplace through a one stop shopping and 
management for all your documents. Enabling Revision Control provides the ability to manage 
multiple versions of a document contained within an Application. 

Note: Revision Control functionality has additional features that can be used to tightly 
control the document management process. Please see the below sections for additional 
information. 

1. On the iSynergy Menu bar, select Admin>Applications. 

Note: If you have created the application, simply select and modify it. If you have not 
created the application, select Add Application. 

2. Select Enable Revision Control 

3. Continue creating or modify the Application. 

4. Select Update. 

5. When you are finished, select Implement. 

Enabling Revision Tracking and Audit Trail 

The Revision Tracking and Audit Trail option provides the ability to track the document versions.  
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Note: This is an application setting and will only be available if Revision Control is 
enabled.  

 

Utilizing both Enable Revision Control and Enable Revision Tracking and Audit Trail application 
settings, provides the ability to track all document changes as separate revisions. This 
functionality allows a user to roll back to previous versions of a document, view the original 
document and recover the original document by promoting it back to the current or most recent 
version of the document. 

Note: In addition to these application settings, the user must also have defined Account 
Functionality Management permissions. Please review the permission section of this 
manual for additional information. 

To enable Revision Tracking and Audit Trail, follow the below steps. 

1. On the iSynergy Menu bar, select Admin>Applications. 

Note: If you have created the application, simply select and modify it. If you have not 
created the application, select Add Application.  

2. Ensure that Enable Revision Control is selected. 

3. Select Enable Revision Tracking and Audit Trail. 
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4. Continue creating or modifying the application. 

5. When you are finished, select Update. 

6. Select Implement. 

Enabled Document Level Security 

Document level security enables a System Administrator to grant access to an iSynergy 
Application while limiting the access rights to particular Documents contained within that 
Application.  

 

For example, perhaps in the HR application, you want to give a manager the ability to 
securely view any document in the application, but you want the payroll department to 
only have access to the Pending New Hires and Submitted to Accounting status values.   

When you are adding indexes to applications with document level security, the security setting for 
the new indexes for each User and Group must be selected. 

Note: The Application does not need to be De-implemented to enable Document level 
security. 

To activate Document level security within an Application, follow these steps: 

1. On the iSynergy Menu bar, select Admin>Applications. 

2. Navigate to and select the Application you want to edit. 
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3. Select Enabled Document Level Security checkbox. 

4. Select Update. 

User Account Document Level Security  

The following steps configure Document Level Security for a specific user account. 

Note: The Document Level Security procedure is the same for Groups as well, with the 
exception of Step 1. You will navigate to Admin>Group Configuration. 

1. On the iSynergy Menu bar, select Admin>User Configuration. 

 

2. Select the desired Users Access Key. 

 

3. Navigate to Application Permissions. 

4. Select the Application with Document Level Security. 
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5. Select the UDL values you wish to make available to the User or the Group. 

 

Note: To select multiple Indexes hold the Ctrl key and select the appropriate indexes with 
your mouse. Additionally, if a specific user should have permission to access and modify 
the Index, click Select All. 

6. Select Update. 

Force Comments on Check in 

An application can be configured to provide a simple check in/out capability, which will force 
users to check out a document for editing and prevents more than one user from making changes 
to a document at the same time.  

 

Using this application setting, the documents that are checked back in to the application will 
overwrite the original version of the document. Regardless of how the user chooses to check out 
the document, either by downloading or editing in place, when the user is ready to check the 
document back into the iSynergy Repository, a Checkin Document dialog displays and provides 
the ability to enter text.  

When the user has finished typing a comment, select OK and the comments are available to any 
user who has access to that specific application. 

Force comments on check in works with Enable Revision Control and Enable Revision Tracking 
and Audit Trail. When an application uses this functionality, a comments dialog displays upon 
checking in a document into the iSynergy Repository. 
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To active Force Comments on Checkin, follow these steps. 

1. On the iSynergy Menu bar, select Admin>Applications. 

2. Navigate to and select the Application you want to edit.  

3. Select Force Comments on check in checkbox. 

 

4. Select Update. 

Enable Auto Check in for Annotations 

Enable Auto Check in for Annotations is an Application security setting that eliminates the need to 
check in a document when a user only changes annotations on a document and there are no 
physical changes to the image.  
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Note: This is an application setting and will only be available if Revision Control is 
enabled.  

When Enable Auto Check in for annotations is selected, the document is automatically checked in 
upon the user leaving the image in the Viewer; the user is not prompted to check in the 
document, nor is the user forced to make comments on a check in. 

Note: This feature only applies to the case were a user adds, deletes or modifies 
annotations and no other changes to the document are made. If a user checks out a 
document and also performs any other changes to the document, such as a page rotation 
or page deletion, the auto check in for annotations will not apply.  

Exclude from Global Searching 

Global Searching provides the ability to search across all applications based on any index value. 
When an application is created, administrators can tightly control the ability to globally search for 
an index value.  

Global Searching also provides the ability to search for any document, regardless of the status 
and display it on the Search page. Global searches are performed across all enabled Applications 
for which the User has access permissions. Index values matching the search criteria are 
returned regardless of the index type and the index name associated with the index value 
following a global search. 
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Add Indexes to an Application 

Once an Application has been created, you are ready to add indexes. 

For additional reference material regarding Application Setup, please review Appendix 1. 

1. On the iSynergy Menu bar, navigate to Admin>Applications.  

Note: The Application Configuration dialog window displays. 

2. Locate the created Application. 

3. Select Add Index. 

 

4. Enter the Index Name. 

 

5. Select the Index Type drop down and choose the appropriate index type. 
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6. If appropriate, select Required, Sticky and/or Multi-Edit. 

 

Element Description 

Required Provides the ability to require a user to enter a value for an index before 
the document is submitted to iSynergy.  

 

Sticky Provides the ability to keep a data value displayed in the index field after 
the document is submitted to iSynergy.  

 

Note: If a UDL is made sticky, the value last placed in the UDL 
will remain for the next document to be indexed. 

Multi-Edit Provides the ability for an index to be modified for multiple documents 
simultaneously.  
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7. Select Add. 

 

Note: The newly created Index appears in the Application table pane. Within this table, 
you can edit or delete Index values associated with the Application. 

Editing Application Indexes 

To edit an Application index, follow these steps: 

1. On the iSynergy Menu bar, navigate to Admin>Applications.  

Note: The Application Configuration dialog window displays. 

2. Select the appropriate Application. 

3. Select De-Implement. 

 



iSynergy 3.9.3 SBS Advanced User Manual   Page 77 of 186 

4. Navigate to the Index Field you want to edit and select Edit. 

 

5. Make the appropriate changes.  

 

6. Select Update. 

 

7. Select Update. 

 

8. Select Implement. 
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Group and User Permissions 
Account management techniques allow an Administrator to control the levels of document access 
and permissions granted to individual Users and Groups (of users) working within iSynergy.  

Assigning individual accounts membership(s) to group account(s) is an effective way to ease 
account administration overhead. Each user assigned to a group account inherits the permissions 
granted to the group.  

For example, a user assigned group permissions can have additional permissions 
assigned individually to his user account.  

When working with a dynamic information database, it is necessary to institute security measures 
of varying levels among Users within the system to ensure its’ integrity. Within iSynergy, it is 
possible to deny a User or Group access to an Application(s) or to limit functionality while within 
an Application. Various Users may be granted access to Applications pertinent to their duties 
while being refused access to Applications outside the scope of their duties. Additionally, it is 
possible to grant a User or Group access to an Application while limiting access to particular 
Document types or Document statuses within the Application. 

By combining Application level and Document level security approaches, it is possible to create a 
highly granular mode of access control in iSynergy.   

User Account Management 
At the most basic level, User accounts grant an individual authentication and entry privileges into 
iSynergy. Permissions assigned to a User account determine the access and functionality an 
individual has at his/her fingertips when logged into iSynergy. 

The basic configuration attributes of a User account include: 

 User name. 
 Full Name. 
 Email Address. 
 Cost. 
 Account password. 
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Group accounts in iSynergy lessen the task load of the system administrator. The administrator 
can set permissions within Group accounts and subsequently grant membership of User 
accounts to various Groups.  

 

Note: This is a more effective approach than assigning permissions for each User 
account on an individual basis.  

Group Account examples include: 

 Groups based on department membership (Sales, HR, Customer Service). 
 Groups based on job scope and responsibility (scanner operators, data entry personnel, 

analysts). 
 Basic Users group with limited permissions. 
 System Administrators group with full permissions. 

Note: The rights and permissions granted to User accounts based on multiple 
memberships are cumulative.  

Creating a New Group 

To add a new Group to the iSynergy system, follow the below steps: 

1. On the iSynergy Menu bar, navigate to Admin>Group Configuration. 
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Note: The Group Configuration dialog window displays. 

2. Select Add Group.  

 

Note: A new text box displays under the existing iSynergy Groups. 

3. Enter the New Group Name. 

4. Select Add Group.  

 

5. The newly created Group displays in the Group Configuration table. 

 

Modify Group Permissions 

To add or modify permissions of a Group account, follow these steps: 

1. On the iSynergy Menu bar, select Admin>Group Configuration.  

2. Select the Group Access Key. 
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Note: The Application Permission dialog window displays. 

3. Select individual checkboxes to grant specific permissions. 

Note: If you want to give all permissions, choose Select All Permissions and click Update.  

4. Navigate to Application Permissions. 

5. Select the appropriate Application(s) the User Group need permission to access. 

 

6. Select Update. 
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Creating a New User Account 

To add a new iSynergy User, follow these steps: 

1. On the iSynergy Menu bar, select Admin>User Configuration.  

 

Note: The User Configuration dialog displays. 

 

2. Click Add User. 
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Note: This User Details dialog displays. 

 

3. Tab to the Username Field and define the Username.  

 

4. Tab to the Full Name text field and enter the Users full name. 

 

5. Tab to the Email Address text field and enter the Email Address. 
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6. Tab to the cost and define the hourly cost. 

 

Note: This cost field is an optional field; however, if you are using the iDatix Business 
Automation Product, Progression, this cost field will be helpful for production reports and 
tracking the amount of hours an employee spends on a specific task.  

7. Tab to the Password text field and define the Users’ password. 

 

8. Tab to the Confirm Password text field and Renter the Password as defined in Step 7.  

Note: Passwords are case sensitive! Passwords must be unique, and cannot be the 
same as the username. 
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9. Click the Add button to add the new User and his/her details.  

 

Note: Select cancel if you do not wish to add the User details. 

10. The User Configuration dialog displays and the user has now been added to iSynergy.  

Adding a User to a Group 

To add a User to a Group, follow these steps: 

1. On the iSynergy Menu bar, navigate to Admin>Group Configuration 

2. Select the Group Name.  
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Note: The Group Name dialog window displays. 

3. Select an Available User. 

 

4. Select Add.  

 

Note: To make multiple selections, use the Shift or Ctrl keys on your keyboard as 
appropriate. 

3. Click Update. 
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To check the Group membership status of a User, navigate to Admin>User Configuration 
page; the group membership displays in the Member of Groups column.  

Removing a User from a Group 

To remove a User from a Group, follow these steps: 

1. On the iSynergy menu bar, navigate to Admin>Group Configuration. 

2. Select the Group that contains the User you want to remove.  

3. Select the User you want to remove in the Group Members’ column. 

 

4. Select Remove. 

 

Note: The removed user is re-added to the Available Users. 

5. Select Update. 
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6. The selected user is removed from the Group. 

Note: To verify a User’s removal from a Group, load the User Configuration page to 
confirm the User is no longer included within the Group by viewing the ‘Member of 
Groups’ column.  

Delete a User Account 

To delete a User account, follow these steps: 

1. On the iSynergy Menu bar, navigate to Admin>User Configuration.  

2. Locate the user you want to Delete. 

3. Select the desired Username.  

 

Note: The User Details dialog displays. 

3. Select Delete. 
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Note: A Windows Internet Explorer dialog window displays with the selected user name.  

4. Select OK. 

 

 

Permission Management 
Permissions granted to individual users or groups can be limited in nature or broad in scope 
depending on the various roles and the granted rights of the User/Group.  

For example, it may prove prudent to limit permissions granted to data entry personnel. 
They may need access to only one Application for data entry purposes. Additionally, 
Executive Management may be granted permissions pertaining to assignment of Group 
memberships such as adding Applications and creating new UDLs. 

iSynergy permissions are defined initially at the System Level, followed immediately by the 
Application level. 
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System Level Permissions 

iSynergy provides the ability to define system level role assignments to grant access to global 
tasks and permissions that apply to the iSynergy system as a whole. Each user and/or group who 
requires access to iSynergy should have a system level role assignment. System Level 
Permissions can be thought of as the entire filing physical cabinet, these permissions provide 
access to open specific cabinets and files within iSynergy. 

To define a user or groups System Level Permissions, follow the below procedure.  

1. From the iSynergy Menu bar, navigate to Admin>User Configuration. 

 

Note: The User Configuration dialog displays. 

2. Select Add User. 

 

3. Define the new User Details.  
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4. Select Update. 

Note: The user returns to the User Configuration screen. 

5. Navigate to and select the appropriate users Access Key. 

 

Note: The User Permissions dialog displays for the selected user. When a user is initially 
created, System Level Permissions are not selected and only the currently created 
iSynergy Applications are displayed at the Application Level. 

6. Navigate to System Level Permissions. 

Note: Each System Level Permission has been defined in the below table. 
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Element Description 

Application Add Provides the ability to add an iSynergy Application. 

Note: This permission enables the Applications Admin Menu 
item, as well as enable the Add New Application button the 
Application Configuration dialog. 

Application Delete Provides the ability to delete an iSynergy Application. 

Note: This permission enables the Application Admin menu, as 
well as enables the Delete button on the Edit Application dialog. 

User Add Provides the ability to create a new iSynergy user account. 

Note: This permission works in conjunction with the User 
Update permission. You must have both permissions selected in 
order to create a new user.  

User Update Provides the ability to update a user account, as well as update all 
System Level Permissions of another user. 

Note: In order to add a user to iSynergy, you must have both the 
User Add and User Update permission. Additionally, in order to 
delete a user from iSynergy, at the System Level you must have 
both the User Update and User Delete permission selected.  

User Delete Provides the ability to delete an existing user account. 

Note: This permission words in conjunction with the User 
Update permission. You must have both permissions selected in 
order to delete a user. 

Index Type Add Provides the ability to add an index type. 

Note: This permission works in conjunction with the Index Type 
Update permission. You must have both permissions selected in 
order to add and update an index type. 

Index Type Update Provides the ability to update an index type. 

Note: In order to update an index type, you must have both the 
Index Type Add and Index Type Update. Additionally, in order to 
delete an index type from iSynergy, at the System Level you 
must have both the Index Type Update and Index Type Delete 
permission selected. 
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Index Type Delete Provides the ability to delete an index type. 

Note: This permission works in conjunction with the Index Type 
Update permission. You must have both permission selected in 
order to delete an index type. 

User List Add Provides the ability to create a UDL. 

Note: This permission works in conjunction with the User List 
Update permission. You must have both permissions to add an 
iSynergy UDL. 

User List Update Provides the ability to modify a previously created UDL. 

Note: In order to update a UDL, you must both the User List Add 
and the User List Update permission. Additionally, in order to 
delete a UDL in iSynergy, at the System Level you must have 
both the User List Update and User List Delete permission. 

User List Delete Provides the ability to delete a UDL. 

Note: This permission works in conjunction with the User List 
Update permission. You must have both permissions selected 
to delete an iSynergy UDL. 

System Options 
Update 

Provides the ability to update the system configuration options. 

Note: To modify the iSynergy System Options, navigate to 
Admin>System Configuration>System Options. 

User Group Add Provides the ability to create a new user group. 

Note: This permission works in conjunction with User Group 
update. You must have both permissions selected to add an 
iSynergy User Group. 

User Group Update Provides the ability to update a user group. 

Note; In order to update an iSynergy User Group, you must 
have both the User Group Add and the User Group update 
permission. Additionally, to delete a User group, you must have 
both the User Group and User Group Delete permission 
selected. 

User Group Delete Provides the ability to delete a user group. 
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Note: This permission works in conjunction with the User Group 
Update permission. You must have both permissions selected 
to delete an iSynergy User Group. 

Pre Sort Application Provides the ability for a user to access to the General Capture page 
and therefore whether or not the presort general capture option shows 
up in the menu. 

Pre Sort Person Determines if a user may route to an inbox from General Capture. The 
drop down allowing a user to select a user’s inbox to route to is not 
present on the general capture page if the user does not have the 
System Level Permission to Pre Sort Application. 

Inbox Provides the ability to access an inbox for a specified user. Documents 
that are placed in an iSynergy users inbox are available to be routed to 
either another iSynergy Application or another User or Group. 

Note: When a document has been sent to your inbox, you will 
not be able to see the index fields and therefore you are unable 
to update them. Any document that is placed in a users inbox 
must first go through manual indexing before it is submitted to 
an application. Additionally, selecting the Inbox permission 
provides the ability to access the Routing option on the iSynergy 
Menu. 

System Reporting Provides the ability to generate iSynergy reports. 

Note: This permission provides the ability to access 
Admin>Reporting. Additionally, reporting permissions are 
restricted to the Application Level. The document level security 
and security permissions are not enforced with this permission. 

Remove Session Provides the ability to remove other logged in accounts from active 
iSynergy session. 

ScanDox Provides the ability to install the iDatix capture software product 
ScanDox. 

Note: This permission provides the ability to install ScanDox as 
a clickonce application. Navigate to the iSynergy Tool Bar and 
select Tools>ScanDox.  

Work Item List Provides the ability to view Progression work items assigned by user. 

Note: This permission works in conjunction with the Priority Edit 
Permission. 
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Search Any User 
Checkout 

Provides the ability for a user to search checked out documents by other 
users via a drop down on the Search page.  

Note: When this permission is selected, all users are displayed in the 
drop down, plus an All option. 

Search All 
Applications 
Checkout 

Provides the ability to search for a checked out document across all 
applications.  

Note: On the Search page for the Application drop down, when enabled 
there will be an All option. Selecting this option will display a search 
screen to allow the user to find a document check out across all 
applications. 

Work Item List Provides the ability to view the Progression work items. 

Progression Studio Provides the ability to access the Progression click once deployment 
option from the Tools Menu. 

Reassign Tasks Provides the ability to reassign a Progression task that has been 
assigned to the logged in users account. 

Reassign Any Task Provides the ability to reassign any Progression task which is assigned 
to any user or group. 

Priority Edit Provides the ability to change priorities on workflow documents. 

7. Define the appropriate user System Level Permissions. 

8. Select Update.  

Application Permissions 

Once System Level Permissions are defined, you may define the Application Permissions. 
Application level permissions provide the ability to control the user permissions on a per 
application basis, as well as enhance security access to the application.  

After you have defined the user or group system level and application permission, selecting 
update enables the application configuration dialog.  
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iSynergy 3.9 provides the ability to define single application permissions or multi application level 
permissions. 

 
 

Application level security is achieved by granting or restricting Application permissions. 
Application level permissions can be assigned to both User and Group accounts. If the account 
has permission to search an Application, the Application is available from the Application Selector 
drop-down menu in the Search Page. If the Application has been restricted, the User/Group will 
not be aware that the Application even exists, as it will not be visible in the Application Selector 
drop-down menu. 

 

Element Description 

Application Names Provides a complete listing of all applications which have been added to 
iSynergy. 

Doc Level Permission  Provides the ability to define document level security. 

Note: Document Level Security is defined with the unique 
Application. Navigate to Admin>Applications. Select the 
appropriate application and choose enabled document level 
security. 
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Configuration Provides the ability to define the application level permissions by 
Cabinet, System and Account Functionality. Additionally, you may elect 
to configure multiple applications by selecting Multi-App Configuration. 

Cabinet Management Permissions 

iSynergy provides complete application security that can be defined at the cabinet, system and 
account functionality level. Cabinet Management permissions are the permissions for the overall 
application. In other words, you can think of the cabinet as the drawer you would pull out in a 
filing cabinet. Cabinet management is the organization of how you are going to file documents in 
that specific drawer. 

When a new Application is implemented in iSynergy the default access is restricted. The system 
administrator must explicitly enable access to the new Application by updating account 
permissions. 

 

Selecting the appropriate Application configuration icon displays the application level permission 
for the chosen application. These application level permissions are determined at the following 
levels: 

• Cabinet Management. 

• Account Functionality Management. 
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Element Description 

Application Update Provides the ability to update any Application. 

Index Add Provides the ability to add new Index(s) to an Application. 

Index Update Provides the ability to update a specific Index type. 

Index Delete Provides the ability to mark for deletion (no purge) any index. 

Application 
Management 

Provides the ability to manage an application. 

Note: This permission provides the ability to utilize the Account 
Functionality Management permissions.  

Account Functionality Management Permissions 

Account Functionality Management Permissions provide the ability to work within the Application. 
These permissions are specific for user interaction with the documents stored in each unique 
iSynergy Application. 



iSynergy 3.9.3 SBS Advanced User Manual   Page 100 of 186 

 

Element Description 

Route Application Determines if a user may route documents out of an application. 

Route Person Determines if a user may route to a users inbox from this application.  

Indexing Edit Provides the ability to update index values. 

Indexing Multi-edit Provides the ability to edit multiple indexes simultaneously.  

Email Provides the ability to send email with object attachments. 

Assignment This is not an active permission. 

Query Save Provides the ability for the user to save a query. 

Query Delete Provides the ability for the user to delete a saved query. 

Document History 
Report 

Provides the ability for system events history to be displayed with the 
Reporting functionality.  

Document Hard 
Delete 

Provides the ability for an object to be purged from system, or true 
deletion from storage subsystem. Hard delete permission enables the 
view of iSynergy’s Object Status Field to the group. 

Document Soft Delete Provides the ability for an object to seem to be deleted from iSynergy, 
but it is flagged for purge from system. 

Annotation View Provides the ability to view any existing Annotations. 

Annotation Edit Provides the ability to create, edit, or delete Annotations. 

Note: By default, this permission also provides the ability to view 
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the annotation you have created. 

Annotation Add Provides the ability to add, edit, and delete new annotations. 

Note: By default, this permission also provides the ability to view 
the annotation you have created. 

Hide Redaction Provides the ability to hide Redactions when a user selects the Hide 
Annotations Icon in the Viewer. The user can then see under redaction 
annotations. 

Note Add Provides the ability to View and Add new notes.  

Note: This permission is dependent on Note View. 

Note View Provides the ability to View pre-existing notes.  

Note: This Permission is necessary to allow Adding of Notes. 

Print Image Provides the ability to print an image. 

Scan Image This permission is not being used. 

Export Provides the ability to export a Document out of the iSynergy. 

Show All Statuses Provides the ability to display searchable and unsearchable items that 
normally would not display based on search criteria. 

Edit Object Status Provides the ability to allow a user to change an object status. 

Annotation Edit Own Provides the ability to create, edit or delete annotations. 

Revision Control Provides the ability to enable revision control within a designated 
application. 

Document View 
Revisions 

Provides the ability to review document revisions within a designated 
application. 

Note: This permission is dependent upon Revision Control 
being selected. 

Undo Any Checkout Provides the ability to undo any checked out document. 

Download Document Provides the ability to select the download option and save it to a 
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directory of your choice. 

Promote Revision Provides the ability to make a revision the current version of a 
document. 

Delete Revision Provides the ability to delete revisions from an application. 

Manual Indexing Provides the ability to manually index a document. 

Note: This permission provides the ability to view the Indexing 
Menu option on the iSynergy Tool bar, as well as display with 
applications are available in the drop down menu.  

Upload File Provides the ability to upload a file while in iSynergy.  

Note: This permission is located in the Indexing Menu. 

Select All 
Permissions 

Checkbox enables all permissions for all items under Cabinet 
Management, System Management, Account Management, and 
Account Functionality Management. 

User Permissions 
To add or modify User account permissions, follow these steps: 

1. On the iSynergy Menu bar, navigate to Admin>User Configuration.  

Note: This User Configuration displays. 

2. Navigate to the Appropriate User. 

3. Click the desired User Access Key. 

 

Note: The selected User Permissions dialog displays.  

4. Navigate to Login Expiration.  
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5. Select the Drop Down Menu and choose the appropriate option. 

 

Note: If you wish to force the user to define a new password, select Reset Password Next 
Login. 

 

6. Select the Appropriate System Level Permissions.  
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Note: If all permissions in the aforementioned groups are to be given to the user, click 
Select All. 

7. Navigate to Application Permissions and choose the appropriate Application. 

 

Note: If all Applications are required for the user, click Select All. 

8. Click Update. 

 

Routing Documents 
The process of routing a Document allows a User to move it from its current location to a 
separate destination. Routing is a very useful tool that is analogous to moving a Document from 
one work area to another in a traditional office setting.  
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There are multiple reasons it might be necessary to route a Document. There are also many 
possible variations for the origin and destination of a Document’s path. These various scenarios 
are discussed in this chapter. 

The General Capture Application 
General Capture, as its name implies, is a filing Application that serves as the general point of 
capture for non-indexed Documents entering the iSynergy system. Because they have no 
Indexes, Documents held in General Capture are not associated with a specific Application. In a 
traditional office General Capture is analogous to a stack of Documents (commonly at the front 
desk) that have yet to receive their first “look over” to be directed to their proper departments 
within the building.  

The General Capture Application can accept Documents from various sources, including: 

• ScanSpeed. An application that works in conjunction with a scanning device to convert paper 
Documentation to an electronic image format called TIFF (Tagged Image File Format). 
iSynergy receives these images and then archives them. 

• iScan. An application, more rudimentary than ScanSpeed, that works in conjunction with a 
scanning device to convert paper Documentation to an electronic image format called TIFF 
(Tagged Image File Format). iSynergy receives these images and then archives them. 

• QuickIndexer. An application that takes new and old electronic files archives and puts them 
into iSynergy.  

• ScanDox: ScanDox replaces (or incorporates all elements of) ScanSpeed, iScan and 
QuickIndexer. 

• iSynergy Services. A service that moves electronic files from a designated destination 
directory to a directory that iSynergy can access.  

Note: For further information, see the eSpeed Services section found at the end in this 
Document. 

Three possible destinations exist for Documents exiting the General Capture Application: 

• A different iSynergy Application. 

• The InBox of an iSynergy User. 
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• The InBox of an iSynergy Group. 

 

Pre-Sort General Capture 
Pre-Sort General Capture allows Documents stored in General Capture to be sorted and routed 
to various destinations for indexing. Documents chosen from the Queue Indicator are shown in 
the Document Pane (the Document Pane is not shown in the screen shot below). 

The following elements of Pre-Sort General Capture are described below: 

• Queue Indicator. 

• Application Option. 

• Inbox Selector. 

• Inbox Activation. 

• Cancel Option. 

Queue Indicator 

Queue Indicator shows how many Documents are waiting for to be routed from the General 
Capture Application. It also displays which Document is currently loaded in the Document Pane. 
The Queue Indicator contains a VCR control. 
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Application Selector 

Route an active Document in the Document Pane to a destination Application by selecting the 
Application from the Application Selector. Clicking a particular Application button sends the active 
Document to that Application. The next Document in the queue then loads in the Document Pane 
and is ready to be routed. 

 

Assign to User/Group 

Route a Document to User or a Group InBox by selecting the appropriate option from the Assign 
to User/Group drop-down field. Routing a Document to a specific User allows only that User to 
receive the Document in his/her Inbox. Routing a Document to a Group allows any member of 
that Group to view and process the Document. 



iSynergy 3.9.3 SBS Advanced User Manual   Page 108 of 186 

 

The InBox Page 

Each account in iSynergy has the capability of receiving routed Documents to its Inbox. This 
capability applies to both user accounts and group accounts.  

 

The Table Title displays from which Application the sent Document(s) originated. 

T bl
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If the account InBox contains Documents that originated from more than one Application, each 
Application contains Documents displayed in a separate Document Table. 

Document Tables contain Documents for routing. Each table consists of three Columns: 

Element Description 

File Column Provides the ability to active a Document in the Viewer. 

Assigned Column Provides a simple discovery of the date and time the Document was 
routed to the InBox. 

Route Column Provides the ability route a document to a destination application and/or 
a User/Group InBox. 

Routing Documents 
This section covers the process of routing Documents in iSynergy. The following routing 
scenarios are possible: 

• Pre-Sort General Capture to an Application. 

• Pre-Sort General Capture to an Inbox. 

• Route Inbox to an Application. 

• Route Inbox to a different InBox. 

• Route Application to a different Application. 

• Route Application to an Inbox. 

Pre-Sort General Capture to an Application 

The following shows how to route a Document from the Pre-Sort General Capture Application to a 
different Application: 
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1. From the iSynergy Menu bar, select Routing and click Pre-Sort General Capture. 

 

2. Select the Application you want to route the document to. 

 

Note: A Microsoft Internet Explorer dialog displays. 

 

3. Select OK. 

Pre-Sort General Capture to an Inbox 

To route a Document from the Pre-Sort General Capture Application to an InBox, follow these 
steps: 

1. From the iSynergy Menu bar, select Routing and click Pre-Sort General Capture. 

2. Select the User/Group Name on the account name and the Document to route it to the 
account InBox. 
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3. Select OK. 

Route from an Inbox to an Application 

To route a Document from an Inbox to an Application, follow these steps: 

1. From the iSynergy Menu, select Routing and click Inbox. 

 

2. Select Route. 

 

Note: The iSynergy Inbox routing page displays.  

3. Select the appropriate Application button. 

4. Select OK. 
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Route from Inbox to Inbox 

Routing from one Inbox to another Inbox is very similar to routing from an Inbox to an Application. 
When the Index routing page is loaded, choose an account name rather using the Application 
option. 

To route a Document from an Inbox to a different Inbox, follow these steps: 

1. From the iSynergy menu, select Routing and Inbox. 

 

2. Select Route hyperlink. 

 

3. Select the appropriate Application button. 

 

4. Select OK. 
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Route from Application to Application 

If the document was misclassified or to route a Document from an Application to another 
Application, follow these steps: 

1. Locate the indexed Document you wish to route, right click the file icon.  

 

2. Select Edit Indexes. 

 

3. Select the Route button to access the main Routing page. 

 

4. Click the appropriate Application selector button for the Document to be routed, or you may 
choose to route to an inbox. 
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It is also possible to route from Application to Application while indexing Documents on 
the Indexing page. To route while indexing Documents, click the route button on the 
bottom right of the Indexing page.  

Indexing Documents 
Indexing is the act of adding Index values to a Document. Indexing can be a manual or 
automated process. Documents that have received indexing are searchable within iSynergy.  

Access and functionality of the Indexing page is based on user permissions. 

Note: For more information regarding permissions, please review the Permission 
Management Section of this manual. 

The Indexing Page 
The functional regions of the Indexing page include: 

• Application Selector. 

• Document Navigation. 

• Index Fields. 

• Submit. 

• Submit to RapidDoc. 

• Delete. 

• Route. 

 

Application Selector 

The Application Selector drop-down list allows you to select the appropriate Application 
containing Documents for Indexing. The number in parentheses next to Application name 
indicates how many Documents exist in the Indexing queue for that Application. 
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Document Navigation 

The Document Navigation allows you to scroll through and view the Documents in the Indexing 
queue, as well as locate Documents that require immediate indexing. 

 

Index Fields 

Index fields are regions that accept entry of Index values that correspond to the active Document. 
Index fields may be text, drop-down or range fields. Notice symbols exist next to some Index 
fields. These symbols indicate attributes an Index field can possess. A red asterisk next to an 
Index value indicates that value is required for submission to iSynergy. 

 

Submit 

To submit an Indexed Document to iSynergy, click Submit.  
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Note: After a Document has been submitted, the Indexing Page automatically launches 
the next Document from the indexing queue to the viewer to continue indexing. 

Delete  

Use Delete to remove a Document from the Indexing queue.  

 

Documents deleted from the Indexing queue receive a soft delete. Users must have permissions 
to perform a soft delete. To perform a hard or permanent delete of a Document from iSynergy 
requires additional granted permissions,  

Note: When a Document has been soft deleted the Indexing page, the next document 
loads in the Indexing queue for processing. 

Route 



iSynergy 3.9.3 SBS Advanced User Manual   Page 117 of 186 

Occasionally misclassification of a Document occurs after scanning, or it may be sent to the 
wrong Inbox during Pre-sort General Capture. The Route option allows data entry personnel to 
route the Document to the proper Application.  

 

Note: When a document has been routed, all the previous index values are lost. For more 
information regarding routing, please review the Routing section of this manual. 

Access the Indexing Page 

Access and functionality of the Indexing page is determined by user permissions. 

To access the Indexing page, follow these steps:  

1. From the iSynergy Menu bar, select Indexing.  

 

2. Click the Application selector and choose the appropriate Application.  
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Note: The Application with Documents that require indexing loads. 

1. Enter the correct Index values for the Document.  

 

2. Select Submit. 
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Note: Depending on your process, you may elect to Submit to iSynergy or you may 
Submit to RapidDoc.  

Multi-Edit Function 

The Multi-Edit function provides a (permissions granted) user the ability to edit an Index value for 
multiple Documents simultaneously.  

Note: To edit multiple documents at one time, when the Application was set up and the 
indexes created, the administrator must have selected the multi-edit functionality. 

 

To use the Multi-Edit function: 

3. Select the appropriate Document checkboxes. 



iSynergy 3.9.3 SBS Advanced User Manual   Page 120 of 186 

 

4. Make the appropriate changes. 

 

5. Select Submit. 
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6. The Application Pane refreshes and displays the changes made. 

 

Annotations 

Seven buttons in the top toolbar allow you to create and manage these annotations.  

They include: 

• Insert Annotation 

• Insert Redaction 

• Insert Highlight 

• Insert Rubber Stamp 

• Hide Annotations 

• Pan 

• Select Annotation 

To insert a note annotation, follow these steps: 
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7. Select Note Annotation. 

 

8. Draw a box of any size and drop it anywhere on the image. 

9. Type a notation message in the yellow text box. 

 

To edit a note annotation, follow these steps: 

10. Right-click on the Annotation  

11. Select the Annotation option.  

  

Note: In the child menu, options exist for making changes to the font, foreground and 
background color, as well as moving the annotation front or back.  From the parent drop-
down menu, the user may also cut, copy, and clear the Annotation.  

If you select Text or Background Color from the submenu, the palette displays. 
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Annotation Properties 

iSynergy annotations have extended properties that are modified by right clicking on the selected 
annotation and choosing the appropriate property from drop-down menus.  

Properties included in the parent drop-down menu include: 

• Cut– Removes the selected annotation from the Document. An annotation that is Cut can 
however be pasted to another region of the current Document by subsequently using the 
Paste command. 

• Copy – Copies the selected annotation for a subsequent Paste. 

• Paste - Places the most recently copied or cut annotation on the Document. 

• Clear – Removes the selected annotation from the Document. This removal is permanent 
and the annotation is not stored in the clipboard for Paste. 

• Properties – Selecting Properties activates a pop-up menu containing the Text and Line 
options. The Text option allows you to edit the content of the text currently entered in note 
annotations, but not the font or size of the associated text. The Line option allows you to edit 
the thickness of lines associated with inserted Rectangles, Ellipses, Arrows, and of course, 
Lines. Properties included in the child drop-down menu of the Annotations option include: 
Font, Foreground Color, Background Color, Bring to Front, and Send to Back as seen in 
Figure 92. 

• Font – Selecting font activates a pop-up menu containing options to edit various font 
attributes of the text in annotations. 

• Foreground Color – Changes the foreground color to that selected within the color palette. 
The foreground color of note annotations corresponds to the color of text contained within the 
note. For shapes, lines and arrows, the foreground color corresponds to the color of the line 
associated with the boundary of the shape or the line itself.   

• Background Color  - Changes the background color to that selected within the color palette. 
The background color of Notes corresponds to the color of the Note.  For shapes, the 
background color corresponds to the “fill” color of the shape. 

• Bring to Front – Moves the selected annotation to the front. This allows for placement of one 
annotation “on top” of another.  

• Send to Back  - Moves the selected annotation to the back. This allows for placement of one 
annotation “behind” others.  

Creating and Modifying Rubber Stamps 

To create a rubber stamp, follow the steps below. 

1. On the iSynergy Menu bar, navigate to Admin>Rubber Stamps.  
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Note: The Rubber Stamp Configuration dialog displays. There are three default rubber 
stamps available: Denied, Received and Approved. 

2. Select Add Rubber Stamp. 

 

Note: The Edit Rubber Stamp page displays.  

3. Define the Rubber Stamp Name. 

 

4. Press tab and select the Color Drop Down menu. 
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5. Press tab and select the Font Drop Down menu. 

 

6. Press tab and select the Font Style Drop Down menu. 

 

7. Press tab and select the Font Size Drop Down menu. 
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Note: Additionally, you can use the Rubber Stamp Legend to provide additional 
information for the Rubber Stamp display option. 

 

8. Select Create. 
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9. The new rubber stamp displays in the Rubber Stamp Configuration dialog. 

 

To edit a Rubber Stamp, follow these steps: 

10. On the iSynergy Menu bar, navigate to Admin>Rubber Stamps. 

11. Select the appropriate Rubber Stamp Name Hyperlink.  

 

Note: The Edit Rubber Stamp dialog appears.  

12. Make the appropriate changes. 

 

Note: The Rubber Stamps Legend provides the ability to add additional information to the 
Rubber Stamp display options. 
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13. Select Update. 

 

Data Transfer 
The Export option displays the available export configurations for the Documents selected from 
the search results.  

 

Documents can be exported from iSynergy to remote locations via FTP (File Transfer Protocol) 
across the Internet. For security purposes, only Users with granted permissions can export 
Documents from iSynergy.  

Note: For more information regarding user permissions, please review the Permissions 
section of this manual. 

Once documents have been received, the imported Documents can easily be viewed and 
searched (assuming Index values were included in the export) with the use of CDViewer. Once 
you have gathered the required information for data transfer, such as a target IP address, it is 
very easy to implement a data transfer from iSynergy.  

iDatix Client Support Services recommends that you follow these steps in order: 

1. Create local Directories on the Server to store  
2. Create new FTP Configurations (if required). 
3. Create Export Configurations. 

Create a Data Transfer Configuration 

Before you can transfer Documents, you must create the appropriate Export and FTP 
configurations.  
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To create a data transfer configuration, follow these steps: 

1. On the iSynergy Menu bar, navigate to and select Admin>Data Transfer. 

 

Note: The Data Transfer Configuration dialog displays, providing the ability to add or edit 
the configuration settings for Export and FTP. Additionally, the order in which you add a 
new Export or FTP configuration is not critical, but if the goal is to transfer Documents 
using FTP, it is useful to setup the FTP configuration first.  

Setting the FTP Configuration 

To configure an FTP configuration, follow these steps: 

1. Navigate to the FTP dialog pane and select Add.  

 

Note: The FTP Configuration dialog displays. 
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2. Define the Appropriate information for the FTP. 

Note: Please refer to the below Element/Description Table for field explanations.  

3. Select Add. 

Descriptions of each of the fields within the FTP Configuration page follow: 

Element Description 

Export Name Displays the named export file. 

Server Name Displays the FTP location that you will pull information from. 

Remote Directory Enter the directory on the remote site to which the files are to be 
transferred. 

Username Displays the user name 

Password Provides the ability to define the users’ password. 

Confirm 
Password 

Provides the ability to confirm the defined users password. 

Add Saves the newly created FTP configuration. 

Cancel Cancels the Action 
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Setting the Export Configuration 

After you have determined the FTP information, you are ready to define the export configuration. 

1. Navigate to iSynergy Menu and select Admin>Data Transfer. 

Note: The Data Transfer Configuration dialog displays. 

2. Navigate to the Export pane. 

3. Select Add. 

 

Note: The Export Configuration dialog displays. Please review the below table for 
Element/Description information. 

Element Description 

Application From the drop-down list of available Applications, select the Application 
that contains the data to you wish to export. 

Export Name Enter a name for the export configuration. It is suggested that the name 
include the company to which the data will be exported or some other 
unique characteristic. 

Directory Enter the directory where the files are to be stored. This folder will be 
used as a source file for the FTP transfer. Note: This directory reflects 
the server’s file system. 

FTP Select the desired FTP configuration (for FTP transfer only). The FTP will 
need to be configured on the FTP Configuration page and saved before it 
displays in the drop-down list. 

Zip Files Select this option if you want the exported files to be compressed using 
Zip format. If the files are going to be transferred via FTP this checkbox 
is marked by default. 

Include 
application 

Select this option to export information about the application from which 
the images are exported.  (Used when exporting information from one 
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Element Description 

information iSynergy database to a different iSynergy database). 

Include column 
headings 

Select this option to include column headings in the export file. 

Include images Select this option to include copies of the image files in the export. 

Indexes to be 
Exported 

Select the index information to be included in the export file. 

Select All Selects all options and indexes listed. 

Searching for Documents 
Productive search and retrieval processes are central to iSynergy’s functionality. A query in 
iSynergy is the act of performing a search to retrieve target-specific information from the iSynergy 
database. Similar to a search performed on the internet, a query within iSynergy retrieves 
Documents according to search criteria, called Index values.  

A search query begins with submission of an Index value, such as a date or social security 
number. iSynergy examines the database for Documents with matching Index values and returns 
the results.  

By default, the Search page loads following a successful log in.  

Note: Menus and fields displayed on the Search page may vary per user depending on 
permissions granted to each user by the administrator. 
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Simplicity and efficiency are two goals of the iSynergy search functionality. There are five main 
types of searches performed in iSynergy: 

• Unspecific Search. No Index values are used. This search is performed within a specific 
Application. 
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• Specific Search. One Index value is used. This search is performed within a specific 
Application. 

 

• Complex Specific Search. Two or more Index values are used. This search is performed 
within a specific Application. 

 

• Global Search. A search across all enabled Applications for a given index value, regardless 
of Index Name or Type. This search is capable of incorporating multiple Applications.  
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Note: Global Searching is often dependent upon a User’s permission and the Application 
permission. For more information regarding permissions, please review the Permissions 
section of this manual. 

• Cross Query Search. A search across all enabled Applications for a given index value, but 
limited to a single Index Name. This search is capable of incorporating multiple Applications.  

 

Note: Cross Query Searching is often dependent upon a Users’ permissions and the 
Application permission. For more information regarding permissions, please review the 
Permissions section of this manual. 

Unspecific, Specific and Complex Specific searches are always performed within an explicitly 
chosen Application. Wildcards can be used to expand the search parameters of Specific and 
Complex Specific searches when the absolute value of an Index is uncertain.  

Global searches and Cross Query searches apply across all enabled Applications in iSynergy for 
which a user is granted Application permissions. Global and Cross Query searches share some 
similarities and have some important differences. Both types search across all enabled 
Applications (for which a User is granted Application permissions). However, a Cross Query 
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search is limited to returning search results that share the same Index Name, while a Global 
Search will return matching Index values among all enabled and permissible Applications 
regardless of the Index Name.  

For example, two separate Index Names (displayed as Index Value column headers the 
Results table) may exist that share a common value. One Index Name called ‘Mortgage 
Status’ and another called ‘Hire Status’ may share a common Index value ‘Active’. A 
Global search performed for ‘Active’ will return matching results from both ‘Mortgage 
Status’ and ‘Hire Status’. A Cross query search performed for ‘Active’ within ‘Hire Status’ 
will return matching values from only the selected Index Name, in this case ‘Hire Status’. 

Unspecific Search 

An Unspecific search is performed by submitting an empty query string within a selected 
Application. Submission of an Unspecific search within iSynergy returns all the records in the 
selected Application up to the first 10,000 records (dependent on Admin settings).  

To execute an Unspecific search within an Application, follow these steps: 

1. Navigate to iSynergy Menu bar. 

2. Select Search. 

 

3. Choose the desired Application. 

 

4. Ensure that all index fields are empty and that no value is selected for any UDLs. 
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5. Click the Search button. 

 

6. Results of the search are returned and displayed on the Document Viewer Pane. 

Note: By default, the first Document listed in the table is highlighted in dark blue with its 
first page displayed in the Document Pane. 
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Following a successful search (returning at least one match), the Results page displays the 
result(s) in the Results table.  

Note: If no data is available, the user is alerted via the Application Pane. 

 

Specific Search 

A Specific search refines and narrows results by returning only Documents whose Index values 
match those submitted during the search. Values can be entered into a standard field as a text or 
numeric value, selected from a UDL drop-down list, or entered in a range field. 

To execute a Specific search inside an Application, follow these steps: 

1. Navigate to iSynergy Menu bar. 

2. Select Search. 

 

3. Choose the desired Application. 
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4. Enter or select a value from a standard, drop-down or range field. 

 

5. Click Search.  

 

6. The desired Document displays in the Document Viewer Pane. 
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Complex Specific Search 

A complex Specific search is the most specific search performed within iSynergy. A Complex 
Specific search makes use of multiple Index values.  

Remember that iSynergy only returns results that match all of your Index values.  

To execute a Complex Specific search, follow these steps: 

1. Navigate to iSynergy Menu bar. 

2. Select Search. 

 

3. Choose the desired Application. 

4. Enter Search Criteria Values in the Index fields. 

 

5. Click Search. 
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6. The Document Viewer Pane displays the Document. 

 

Global Search 

Global searches are performed across all enabled Applications for which the User has access 
permissions. Index values matching the search criteria will be returned regardless of the Index 
Type and Index name associated with the Index value following a Global search.  

The Global Search Tool is located at the top of the Search page and rests just below the Links 
Bar.  

To execute a Global Search, follow these steps: 

1. Enter an Index value in the Global Search input field. 

 

2. Select Global.  
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3. Matching values are returned for each Application enabled with Global Search functionality 
that the User has been granted access permissions. 

 

Note: Global Search Results are Simple to Discover; they display in red. 

 

Global searches can also be performed with less specific search criteria. No wildcard symbols are 
necessary for this approach. Making use of a less specific search term broadens a Global search 
and may prove useful when you are not certain of the exact Index value, but are aware of the 
beginning string of letters or numbers associated with the Index value. 
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Cross Query Search 

You may recall that each Index value displayed in a Results table is a hyperlink. Clicking an Index 
value in the Results table begins a Cross Query search for that Index value. Clicking an Index 
value contained in a Results table is the only method available to perform a Cross Query search. 
No Index field is available on the Search or Results pages to enter search criteria to begin a 
Cross Query search. 

A Cross Query performs a search across all enabled Applications (that a user has been granted 
access permissions) for matching Index values that share the same Index Name as the Index 
value chosen to initiate the search. Cross Query restricts search fields to only those Index Names 
you wish to have searched.  

As an example, if two Index Names exist, one called Document Status, the other called 
Hire Status, share a common UDL value of ‘Active’, a Cross Query search of ‘Active’ 
initiated from the Column with Index Name of Hire Status will only return matching results 
from Applications with the Index Name Hire Status. A Global search for the term ‘Active’ 
would have returned matching values from both Document Status and Hire Status. 

To perform a Cross Query search, follow this step: 

1. Click the Index value you wish to Cross Query search from the Results table. 

 

2. The Cross Search Results display. 
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Results of a Cross Query search are listed in table(s) with the Application name above its 
respective table. The Index value used for the search displays in red in its respective Index Value 
column. Notice that the Index Value column header (synonymous with Index Name) is the same 
for both returned results. This will always be the case when performing a Cross Query search. 

Wildcard Searches 

A wildcard search extends search capability in iSynergy by allowing searches to be performed 
using incomplete search strings. In a wildcard search the asterisk character is used to replace the 
unknown portion a search string entered in an Index field.  

The table below outlines the possible uses of the wildcard asterisk:  

Element Description 

a* Returns any character string beginning with the letter  a 

*a Returns any character string ending with the letter  a 

*a* Returns any character string containing the letter  a 

9* Returns any character string beginning with the number  9 

*9 Returns any character string ending with the number  9 

*9* Returns any character string containing the number  9 
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Note: Wildcard searches are useful when you only know a portion of the information you 
want to search. Perhaps you remember only the first three digits of a check number you 
wish to find. If so, you could enter the first three digits followed by a wildcard (123*). 

Additionally, wildcards are not used with Global searches. For Global searches simply enter the 
incomplete search term in the Global search text field. There is no need for a wildcard asterisk. A 
Global search will return all values that begin with search string entered. For example, when the 
search string ‘ja’ is used for a Global search it will return Documents with Index values such as 
‘Jake Edwards’ and ‘James Thomas’ because they both begin with ‘ja’.  

In-Application Wildcard Search 

To execute a wildcard search from within an Application, follow these steps: 

1. Choose the Application and the Index field you want to search.  

2. Enter the known characters of the Index value and include (only) one asterisk to replace all 
the unknown character values, whether the unknown characters are limited to the beginning 
of the search string, the end of the search string, or occur both. 

3. Click Search. 

Full Text Search 

Full Text search allows fast and flexible indexing for a key word based query that is stored in the 
iSynergy Repository. feature incorporates “Google-like” search functionality for Documents that 
have received FullText processing. FullText searches allow a User to search for specific search 
strings within a Document independent of the Index values assigned to that Document.   

Full Text searches are not case sensitive. However, when using search clauses to increase the 
functionality of a search, the search clauses themselves are case sensitive.  

Six search clauses can be used in conjunction with Full Text Search. These include: 

AND Search 

By default, a User can enter a single word during a Full Text Search. The server then returns 
Documents that contain occurrences of that specific word. However, when the user enters two or 
more words as search criteria the server returns only those Documents that include occurrences 
of all words contained in the search. The AND clause is implied between each word in a multi-
word search phrase. 

For example, performing a search with the search phrase ‘White Orchid’ will return only 
Documents contain both the words white and orchid in their content. A Document 
containing only the word ‘white’ or  only the word ‘orchid’ would be excluded from the 
search results. 

OR Search 

An ‘OR’ search is much different than an ‘AND’ search. The User must manually enter an OR 
(case sensitive) clause between each word in this type of search string for it to succeed. Without 
the ‘OR’ statements between words in the string, the string will be interpreted by default as having 
‘AND’ clauses between consecutive words in the search string. When ‘OR’ is placed between 
search terms, Documents with occurrences of any word within the search string will be returned.   
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For example, searching for ‘white OR orchid’ returns Documents that contain either the 
word white or orchid.  

Quoted Search 

A Quoted search allows the user to search for a specific phrase. This is different from an ‘AND’ 
search in that the order of the words in the search phrase are maintained. A ‘Quoted’ search is 
performed by enclosing a worded phrase in double quotes. When a User searches for a quoted 
phrase, the server returns Documents that contain exact matches of the worded phrase.  

For example, searching for ‘“the cat jumped over the fox”’ returns only Documents that 
contain the string ‘the cat jumped over the fox.’ Documents containing all the words 
contained in the phrase, but not in the order quoted, will not be included in the search 
results. 

NOT Search 

In a ‘NOT’ search, the User attaches a minus sign before a word to exclude any Documents that 
contain that word.  

For example, searching for the term ‘Reptiles -lizards’ would yield all Documents that 
contain ‘reptiles’ but excludes Documents that contain ‘lizards.’ 

Wildcard Search 

A wildcard search consists of a word with a character attached that acts like a wildcard. If the 
User enters a word with an asterisk attached, then the server will return Documents that contain 
that word or other words that contain that word.  

For example, searching for ‘He*’ returns Documents that contain the occurrence of ‘He’, 
‘Hello’, ‘Help’, etc. 

Combination Search 

A combination search consists of a query with two or more search predicates. 

For example, an AND, OR, and wildcard search can be combined in one query. For 
example, the query string: “white orchid OR flam* “is a perfectly acceptable query. 

Microsoft SQL Search ignores certain words. Words ignored by SQL search are listed in the 
Table below.  

• Punctuation marks such as colons (:) and semicolons are ignored.  

• Single letters (a, b, c) and digits (0, 1, 2, 3) as well as symbols ($ % ^?) are also ignored.  

• Commas are not allowed and you may not search for quotation marks.  

Single quotes are recognized and treated as a character within a word. 

about be come he is my said the too which 

after because could have it never same their under while 

all been did her like now see them up who 
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also before do here make of should then very with 

an being each him many on since there was would

and between for himself me only some these way you 

another both from his might or still they we your 

any but get how more other such this well  

are by got if most our take those were  

as came has in much out than through what  

at can had into must over that to where  

Last Search 

The Last Search option re-executes the most recent query. 

 

Query Manager 
Query Manager is a feature of the Search page and provides quick and convenient access to 
commonly used search queries. When a User is granted account permission for Query Manager, 
the feature is available on the Search page underneath the active Application’s Index fields.  
Query Manager is Application specific and User Account specific. Each User Account stores 
saved queries for the specific Application in which they were created. Query Manager is a utility 
that stores commonly used search queries to help the user:  

• Load the Application to search. 

• Populate the desired fields for the search. 

• Enter a descriptive phrase in the Save Query As field to easily identified saved queries. 

Save a Query 

To save a query, follow these steps: 
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1. Enter search value(s) in the desired Application’s Index fields.  

2. Enter the name of the query in the Save Query As field in Query manager. 

3. Click the Save Query button. 

 

Execute a Saved Query 

To execute a saved query, follow this step: 

1. Click on the desired query from the Query Name column in Query Manager.  

 

Modify an existing Query 

To edit a query, follow these steps: 

1. In the Search Pane, navigate to the Query Name. 

2. Select the Pencil. 
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3. Make the appropriate changes to your index fields. 

4. Select Modify Query. 

 

Delete a Saved Query 

To delete a saved query from the Query Manager, follow these steps: 

1. In the Search Pane, navigate to the Query Name. 

2. Select the Red X. 

 

Note: A Windows Internet Explorer dialog window displays. 

3. Select OK. 
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Workflow 
Workflow is a defined series of tasks required to produce a desired outcome. Workflow applies 
many of the concepts of factory automation and industrial engineering to the process of work 
management in an office environment. At each stage in the workflow, an individual or group is 
responsible for a specific task or set of tasks. A status change occurs once the tasks are 
complete. Individuals responsible for the next task receive notification of status change. 

 

They receive the data they need to execute the next stage of the process. The result is increased 
productivity, increased control of the process and data, and elimination of the inefficiencies 
associated with manual handling of Documents. 

Workflow Design 

It is possible to define workflow processes within the iSynergy environment. You can define 
assignments and statuses than can be used to drive business processes and track process 
metrics to generate reports on productivity, work status and states of your business operations.  

The most important step in iSynergy workflow implementation is a thoughtful analysis of current 
office procedures. A detailed outline of each step and associated task(s) in the targeted business 
process is the basis of a sound workflow design in iSynergy. Careful analysis can expose 
inefficiencies and guide you toward creating more productive processes and methodologies. 
These outlined steps enable you to combine tasks in logical sets or stages that reflect the flow of 
Documents throughout the organization. 

When setting up your Applications, it is important to consider how Documents flow through your 
process and define the necessary user elements to gain the greatest power and benefits from 
your iSynergy implementation. 

Use a combination of two different kinds of elements to implement Workflow in iSynergy: 

• Status Changes  

• Personnel Assignments  

Both of these features are incorporated into the design of your Applications in the form of User 
Defined Lists (UDLs). 

Note: For more information regarding Workflow design, please refer to the Progression 
Advanced User Manual. 

Status Changes 

Each status name in a UDL represents a stage in the workflow process and that stage is an 
associated set of tasks represented by an index value. An individual or group who has completed 
their assigned stage of the workflow process usually initiates a status change. It is a signal used 
to tell the subsequent individual or group in the next stage of workflow that they may begin their 
assigned set of tasks. 
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Usage Scenario: A manufacturing company wishes to track and manage customer 
orders. The following points list the different departments and associated tasks that are 
required to fill a customer order from order placement to receipt of payment. 

1. Sales Desk. The sales desk answers the incoming customer call, fills out a Sales Order 
sheet, and assigns an order number to the order. Scan the Sales Order sheet into the 
iSynergy system, and assign a status of “Sales Desk” to the Document. 

2. Data Entry. Data Entry personnel key in all relevant information into the ERP system for the 
order. After completion of all tasks, status changes from ‘Data Entry’ to ‘Production.’ 

3. Production. Production staff query iSynergy for Documents with a ‘Production’ status. 
iSynergy returns all orders with a status of ‘Production.’ Production staff can print Work Order 
sheets and begin work on current orders. Once the product is finished, production personnel 
send the product to Shipping, scan the Work Order sheets into iSynergy and change the 
status for the unit from ‘Production’ to ‘Shipping.’ 

4. Shipping. Shipping staff query iSynergy for Documents with a ‘Shipping’ status. They verify 
units received from production against the list of current orders in iSynergy and complete the 
tasks associated with delivery of the product to the customer. Change the status of the order 
from ‘Shipping’ to ‘Invoice’ after the shipping of the orders. 

5. Invoice. Accounting staff search iSynergy for orders with an ‘Accounting’ status. Invoice 
processing begins and, after all current orders have had an invoice sent to the customer, 
accounting staff changes the status from ‘Accounting’ to ‘Review.’ 

6. Review. Review the order. If everything is correct, change the status from ‘Review’ to 
‘Closed.’ 

7. Closed. Close the order and it becomes inactive. 

iSynergy assigns each step in the highlighted status name and creates a UDL called Status 

The status names, placed in the correct order and implemented as a UDL in an Application, are 
called WorkFlow. This Application stores all of the Documentation associated with the order 
fulfillment process. 

Note: For more sample workflows, please refer to the Progression Advanced User 
Manual. 

The Results Page  
Following a successful query, the Results page displays search results in at least one table.  

Note: Results dialog functionality, much like the Search dialog, may vary per user 
depending on rights and permissions granted to each User by the Administrator. 

Functionality of the Results page (dependent on permissions) includes: 

 Application Selector. 

 Page Indicator. 

 Results Table. 

 History. 
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 Multi-Edit Region. 

 Export. 

 Email. 

 Print. 

 Toggle Full Screen.  

 Last Search. 

 Records Indicator. 

 

Application Selector 

The Application Selector enables the user to select a different Application from the one currently 
in use. 

Page Indicator 

Some searches may return large result sets that require several pages to list all results. The page 
indicator shows the number of pages associated with a result set and allows for quick navigation 
through multiple pages of results. 

Results Pane 

The Results pane is a very commonly used component of the iSynergy system. Each row in the 
Results table contains Index value information corresponding to a Document. 

In addition to viewing the results of a query, a User may utilize the Results table to perform the 
following tasks 
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• Select an image of a Document to view. 

• Edit a Document’s Index values. 

• Sort search results by Index values via column header links. 

• Initiate a Cross Query Search. 

• Select Documents for reproduction via email, printing and export. 

• Add a note to a document. 
 

iSynergy Reporting Functionality 
Reporting is a useful feature in iSynergy that gathers standard metrics from business processes 
implemented in iSynergy. Reporting summarizes the data in a meaningful and concise manner. 
These monitoring features allow managers to examine trends in productivity. By analyzing 
productivity trends managers can make better scheduling and assignment decisions. 

Systematic process improvement requires knowledge of current business process statistics. 
iSynergy collects process performance data inconspicuously and reports the results on 
command. The iSynergy database records all significant events associated with every object 
archived in the Repository, including status changes, personnel assignments, reproduction 
events (printing, faxing, and email) and annotation events.  

Note: These events are time-stamped and user-stamped. System Administrators may 
benefit from auditing the tables that contain information pertaining to events and errors. 

The Report page in iSynergy is a set of predefined report templates. To access the Reporting 
functionality, navigate to Admin>Reporting. 

 

Note: Each template has specific elements that define the content of the report 
generated.  

iSynergy Reporting Functionality includes the following report types: 

• Status Summary 

• Batch Report 

• Document Count 
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• Page Count 

For any report you want to generate, complete the following steps. 

1. Select the appropriate Report type. 

 

2. Select the Application. 

 

3. Select Generate. 

 

4. The selected report for the selected application displays. 
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Status Summary 

The Status Summary Report displays a summary of the document status within a specific 
Application in iSynergy. 

To display a Status Summary Report, follow these steps: 

1. Navigate to iSynergy Menu Admin>Reporting. 

2. Select the Status Summary Report.  

3. Select the appropriate Application. 

4. Select Generate. 

5. The Status Report Summary displays. 

 

Batch Report 

The Batch Report Documents the number of batch scan jobs that are sent to iSynergy by 
ScanSpeed, the Document scanning application. 

To create a Batch Report, follow these steps: 

1. Navigate to iSynergy Menu Admin>Reporting. 

2. Select the Batch Report.  

3. Select the appropriate Application. 

Note: You may select additional criteria for the report, such as a User or Date Range. 
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Note: Additionally, you can choose to save the Batch report. 

 

4. Select Generate. 

 

The Batch Report displays. 
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Document Count 

To create a Document Count Report, follow these steps: 

1. Navigate to iSynergy Menu Admin>Reporting. 

2. Select the Document Count Report.  

 

3. Select the appropriate Time Frame. 

 

4. Select the appropriate Application. 
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5. If you any additional reporting criteria, select the appropriate drop down menu. 

For example, you might want to change the date range. 

 

6. Select Generate. 
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7. The Document Count Report displays. 

 

Page Count 

The Page Count Report documents the number of TIFF image pages introduced into (created by 
metric) iSynergy.  

To create a Page Count Report, follow these steps: 

1. On the iSynergy Menu bar, select Admin>Reporting. 

2. Select the Page Count option for the Report field.  

 

3. Select the appropriate Time Frame. 

 

4. Select the appropriate Application. 
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5. If you any additional reporting criteria, select the appropriate drop down menu. 

For example, you might want to change the date range. 

 

6. Click Generate. 

 

7. The Page Count Report displays. 
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System Maintenance 
The section entails general iSynergy “housekeeping” functions performed in the Security 
Manager and System Configuration pages. 

Security Manager 
1. On the iSynergy Menu bar, navigate to and select Admin>Security Manager. 

 

Note: The Security Manager dialog displays. 
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Element Description 

iSynergy 
Application 
Version 

Displays the installed version number of your iSynergy application. 

iSynergy 
Database Version 

Displays the installed version number of the iSynergy database that is 
configured to your application. 

Concurrent Users Displays the number of users currently logged into iSynergy. 

Maximum 
Licensed 
Concurrent Users 

Displays the number of the most allowable users concurrently logged into 
iSynergy. 

System Options 
The System Options dialog displays the parameters by which the iSynergy application is set up in 
relation to your database(s), repositories, servers and other iDatix applications. 

1. On the iSynergy Menu bar, navigate to and select Admin>System Options. 
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Note: The System Options dialog displays. 

 

Element Description 

Maximum 
Records 

Indicates the maximum number of records that are returned as a result of 
a search. If a search would result in 1,000 returned records, but the 
maximum records had been set to 30, only 30 records would ever be 
returned in the search. 

Source Path Indicates the folder from which incoming files are processed  

Repository Path Displays the path where the iSynergy repository resides 

Image Viewer Indicates the state in which the Image Viewer displays by default. 



iSynergy 3.9.3 SBS Advanced User Manual   Page 164 of 186 

Element Description 

Login Timeout Contains the number of minutes after which the system automatically 
logs out a user after this period of inactivity 

Corporate URL Contains the Internet address of the desired corporation. This address 
will be displayed as an active hyperlink in the upper right portion of the 
iSynergy browser. 

Corporate Name Displays the name of the corporation. 

XML Cache Path Displays the location where the XML is stored. 

Document 
Servers 

Displays the location where the Document server is installed. 

License Severs Displays the directory location in which the license servers are installed. 

Passwords 
Encrypted 

Reflects the value selected regarding the encryption of passwords. A 
value of “True” means passwords are encrypted; a value of False 
indicates the passwords are not encrypted. 

DotNet 
Framework URL 

Contains the directory in which the DotNet Framework resides. 

Full Text 
Schedule 

Indicates the hours in which the FullText Service operates. The first 
number shown indicates the start time; the second number shown 
indicates the end time. 

Data Services Contains the directory in which the data services are installed. 

Designer 
Services 

Contains the directory in which any applicable designer services are 
installed. 

Workflow 
Services 

Contains the name of any selected workflow automation applications. 

Reporting 
Services 

Contains the name of designated reporting application 

Application 
Servers 

Contains the directory in which the iSynergy application is located. 

ScanDox Displays the directory path in which the ScanDox application is stored 



iSynergy 3.9.3 SBS Advanced User Manual   Page 165 of 186 

Element Description 

Single Sign On Represents the value indicating the status of single sign on. A value of 
true indicates Single Sign On is activated; a value of False indicates 
Single Sign On is inactive. 

Progression 
Enabled 

Displays the Client ClickOnce deployment location within iSynergy.  

Progression 
Studio 

Displays the directory path in which the Progression application is stored.

Progression 
Notifier 

Displays the directory path in which the Progression application is stored.

Smtp Server Displays the email server for iSynergy. 
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Appendix 1 – Creating an Application Checklist 
Application 

Application Name (Virtual File Cabinet) __________________________________ 

Application Description: 

Indexes 

Indexes to be used as Search Criteria 

(e.g. – SSN#, Name, Doc Type, Date, Status, etc…) 

List the Index Display Order.  What will be the most common Search parameter? 

Order Index Description iSynergy Index Name Index Type UDL Req Sticky ME DB 

         

         

         

         

         

         

         

         

         

         

         

         

         

         

 

Keep as Short as Possible for Data Entry 

• Req = When manually indexing, index value must be supplied 
• Sticky = When manually indexing, value remains after item is submitted 
• ME = Multi-Edit; can change this value on several items at once (used for workflow) 
• DB = Index will be pulled from an external Database 
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Is there an External Database to enhance the Data Entry Operation? 

List Databases and their ODBC Names, Tables and Fields: 

User Defined Lists 

List the “User Defined Lists” (UDL’s) to be used as Index Values (Doc Types, Statuses etc…) 

(Is there an external DB of these values that can be linked to?) 

Attach a listing of all User Defined Lists 

UDL Types  

Name: Name: Name: Name: 
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Application Linking 

List Other Applications that may have relevant information that will need to be crossed referenced 
to items stored in this Application. (For example the relationship between PO’s, Invoices and 
Checks) 

 Other Related Applications 

1) ____________________________ 
2) ____________________________ 
3) ____________________________ 
4) ____________________________ 

List the common index fields between related Applications. 

 Other Related Indexes 

1) ____________________________ 
2) ____________________________ 
3) ____________________________ 
4) ____________________________ 

What will be the formal names of the indexes? 

 Formal Index Names 

1) ____________________________ 
2) ____________________________ 
3) ____________________________ 
4) ____________________________ 

WorkFlow 

List Fields to be used to drive Ad-Hoc Workflow (Status, Assigned User, Process ID) and 
management reports for production metrics. 

1) ____________________________ 
2) ____________________________ 
3) ____________________________ 
4) ____________________________ 

Draw Flow diagram of Workflow Process: 
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Security, Access and Permissions 

Users First Name:  __________________________________ 

Users Last Name:  __________________________________ 

User ID:  ___________________________________ 

User Password:  ___________________________________ 

Permissions: 

 
Application Access (What File Cabinets can be accessed?) 

1) ________________________ 
2) ________________________ 
3) ________________________ 
4) ________________________ 
5) ________________________ 

Document Level Security (What UDL in a Cabinet can be Accesses?) 

1) ________________________ 
2) ________________________ 
3) ________________________ 
4) ________________________ 
5) ________________________ 
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Appendix 2 – iSynergy Status 
Hard Coded Object Status Codes 

• E: Searchable Documents (Appear in the result set for a search in the system.) 

• P: Manual Indexing (Appear in the Manual Indexing screen for user intervention.) 

• I: Routed to Inbox (Documents routed to an individuals or groups inbox.) 

• X: Deleted (Documents that have been soft deleted.) 

• C: Corrupt (Documents that have been determined to be corrupt or of incorrect resolution.) 

• Y: Source Copy (Large multi-page TIFF files that have been separated into smaller sections 
are retained.) 
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Appendix 3 – iSynergy Service 
iSynergy Service  is a Windows service installed on the iSynergy web server and is responsible 
for: 

• Monitoring the incoming folders for all iSynergy applications. When the folders are 
dropped in, iSynergy Service enters a record in the appropriate database for that file.  

• Moving the file to the proper repository and renaming the file with the correct file name.  
• Monitoring printing activity in the iSynergy system and writing a record to the event log 

each time a tiff image is printed from the system.  
• Being used in the export function to write the image files and data for the selected export.  
• Being used in the import function to read the import files, and insert the records into the 

database and the images into the repository.  
• Being used to maintain the directory structure in the repository with regard to the 

application subfolders. 

Troubleshooting iSynergy Service  

• ERROR: iSynergy server not responding to print requests. 
 

Typically, this problem is encountered when a User attempts to print a Document with the 
iSynergy service is not running.  

To troubleshoot this error message, follow these steps: 

1. Navigate to the Windows Start Menu. 

2. Right-click My Computer. 

3. Select Manage. 

Note: The Computer Management dialog displays. 

4. Expand Services and Applications. 

5. Select Services. 

6. In the right pane, right-click iSynergy Services  

7. Select Start. 

8. Log back into iSynergy and verify that Documents will now print.  
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Error Codes 

Code Error Description 

-1 INVALID_PRIMARY_KEY Error during database I/O that returns a primary key. 

-7 EXCEPTION_ENCOUNTERED Negative return codes 

-666 UNINITIALIZED_INTEGER Negative return codes 

0 SUCCESS Always zero 

1000 - 2000 block – O/S Errors 

1001 FILE_NOT_FOUND O/S Errors 

1002 FILE_INSUFFICIENT_PERMISSIONS O/S Errors 

1003 FILE_LOCKED O/S Errors 

1004 IO_ERROR O/S Errors; An external process that 
started, failed. 

1005 EXTERNAL_PROCESS_FAILED O/S Errors 

1006 UNABLE_TO_OPEN_FILE O/S Errors 

1007 INVALID_CMD_LINE_ARG O/S Errors 

2000 – 3000 block – Database Errors 

2001 DB_UNABLE_TO_CONNECT Database Error 

2002 DB_SQL_ERROR The database query returned an 
SQL error. 

2003 DB_REQUIRED_FIELD_MISSING A required field is missing a value. 

2004 DB_CONNECTION_CLOSED The underlying connection to the 
database is closed. 
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2005 DB_INSUFFICIENT_PERMISSIONS The account accessing the database 
lacks permission to perform the 
current operation. 

2006 DB_CONFIGURATION_ERROR The database configuration file is 
incorrect. 

 

Code Error Description 

3100 – 3200 block – Security errors, authentication and authorization 

3100 INVALID_CREDENTIALS The user could not be authenticated 
with the given credentials. 

3101 INSUFFICIENT_PERMISSIONS The user does not have access to a 
document or process. 

3102 ACCOUNT_DISABLED The user’s account has been 
disabled or set inactive. 

3103 ACCOUNT_CLOSED The user’s account has been closed 
permanently. 

3104 PASSWORD_EXPIRED The user’s account has an expired 
password. 

3105 MISSING_CREDENTIALS A SOAP request was received 
without user credentials such as a 
UsernameToken. 

3106 USER_ID_DOES_NOT_MEET_REQUIREME
NTS 

The password does not match the 
regular expression defined for 
validation. 

3107 PASSWORD_ID_DOES_NOT_MEET_REQUI
REMENTS 

The password does not match the 
regular expression defined for 
validation. 

3300 -3400 block – DocumentServer Errors 

3301 INVALID_URI The URL does not contain the 
necessary elements. 
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3302 APPLICATION_NOT_FOUND The application specified by a 
database alias and application does 
not exist in the database. 

3303 DOCUMENT_NOT_FOUND The document specified by a 
database alias, application id and 
document id does not exist in the 
database. 

3304 USER_NOT_FOUND The given user id could not be found 
in the database. 

3305 APPLICATION_NOT_IMPLEMENTED Documents can only be served 
within implemented applications. 

3306 DOCUMENT_SERVER_DOWN The document server is not 
accepting requests. 

3310 APPLICATION_NOT_LICENSED The requested document belongs to 
an application that is unlicensed. 

3311 LICENSING_NOT_INITIALIZED The licensing manager has not 
been initialized. 

3312 INVALID_LICENSE The license file is corrupt. 

 

Code Error Description 

20000 -20099 block – Data Object Model 

20001 INVALID_DATA Data Object Model 

20002 INVALID_TYPE Data Object Model 

20003 INVALID_DATABASE_TYPE Data Object Model 

20004 EXCEPTION_EXECUTING_SQL Data Object Model 

20100 – 20199 block – Data Object Model 

20101 INACTIVE_TASK Workflow Object Model 

20102 INACTIVE_PROCESS Workflow Object Model 
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20103 UNAUTHORIZED_SUBSCRIBER Workflow Object Model 

20104 NO_PRECEDING_TASK Workflow Object Model 

20200 -20399 block – Image, Document Centric Errors 

20200 INVALID_DOC_TYPE Image, document centric errors an 
invalid document type was accessed 
given the current context. 

20201 OCR_FAILURE Unable to OCR document. 

Basic SQL Statements  
The below examples have been provided to help you create a basic SQL statement for use in 
iSynergy. 

View Specific Records in Tables 

 Select * from <table> where <column name> = ‘string’ ex. Select * from _obj_2 where 
IDX_SSN = ‘111-22-3333’ 

 Select * from <table> where <column name> like ‘%partial string%’   

For example, Select * from _obj_2 where IDX_SSN like ‘%111-22-3%’ 

Update Specific Records in Tables 

When using this SQL Statement, do not forget the specific where clause to the record you are 
updating or you might update the entire table in error. Ensure you have isolated a unique record 
with the where clause. 

9. Update <table>  

10. Set <column name> = ‘correct data’ 

11. Where <column name> = ‘current value’ and <column name> = ‘current value’ 

For example,(1) Update _obj_2, (2) Set IDX_SSN = ‘111-22-3333’ (3)  Where objectid = 
2 and IDX_Name = ‘John Doe’ 

View Data Events  

The below select statement is looking for all status changes in the object 2 table that were “P” 
status prior to being changed.  

Note: You can change the oldvalue parameter, objtable parameter and eventdesc as 
needed to create the correct search criteria. 
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 select * from eventlog where oldvalue = 'P'  and objtable = '_obj_2' and eventdesc = 'status'  

View current Group/User Level Permissions 

The below statement is for Users. 

 select permissions.permissionname, users.username  

 from users, permissions, userpermissions 

 where userpermissions.permissionid = permissions.permissionid and users.userid = 
userpermissions.userid 

The below statement is for Groups and Users. 

 select distinct users.username, permissions.permissionname,applications.name, 
usergroups.groupname   

 from applications, users, permissions, userpermissions, usertogroup, 
grouppermissions,usergroups 

 where applications.applicationid = grouppermissions.applicationid and 
userpermissions.permissionid = permissions.permissionid and users.userid = 
userpermissions.userid and usertogroup.usergroupid = usergroups.usergroupid 

iSynergy Web Server, Database and Image Store 
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iSynergy Database Workflow 

Below is a sample workflow of a created Application in iSynergy. 
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Appendix 5 – iSynergy eSpeed Database 
Overview 
Espeed is the iSynergy Database. The Applications created within iSynergy automatically output 
corresponding _obj_x tables with related subfolders to the iSynergy repository folder. The number 
of Applications created in iSynergy correlates directly with the number of _obj_ tables and 
subfolders.  

Products used in conjunction with iSynergy include: 

 ScanSpeed 
 iScan 
 Xtractor 
 Incoming share. 
 QuickIndexer 
 ScanDox 
 iDox 

The tables in iSynergy and the information contained within each are as follows: 

 _obj_1 – By default this table is reserved for the General Capture Application 

 _obj_2 to _obj_x – Application related tables with x representing the last table created 

 Annotations – Records annotations and the objects to which they apply. 

 Application – The Applications created in iSynergy and their related _obj_ table 

 Batches – Batch information for documents submitted from ScanSpeed, ScanDox, or iDox 

 Config-  Stores iSynergy paths and configuration details 

 Datatype – Lists the Datatypes used in iSynergy 

 DefaultIndexes-  Standard iSynergy Indexes – these are your display fields 

 DisplayFields – User specific display fields on the iSynergy viewer 

 Document Status-  The statuses that drive the iSynergy system 

 ErrorLog – Log of iSynergy errors 

 Eventlog – Historical tracking of data events within iSynergy 

 EventTypes – Numeric listing of the types of events tracked in EventLog 

 Exports – Historic record of exports  

 FTPConfig – Contains FTP paths and configuration details 

 FTPDownloads – Incoming ftp files  

 FTSData – Full Text data and its related Application 

 FTSHistory – History of when docs were full text and any errors attached 

 FTSQueue – List of docs waiting for full text processing 

 GroupPermissions – Displays permissions assigned to groups 

 Imports – Files imported into iSynergy and their historic path 

 Inboxes – Emails that will be used with ‘route to’  
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 Indexes – iSynergy standard Indexes and user defined Indexes 

 IndexMapping – Details of how the Indexes relate to the Applications 

 IndexTypes – All Indexes with datatype, field length, formatting, etc.  

 LicenseKeyHistory – History of licensing info including current info 

 LicenseKeys – List of licenses assigned 

 LicenseTypes – Description of each license type use 

 Notes – History of notes created in iSynergy and the objected they relate to 

 PageRotations – Stores information about the rotation of pages for documents in iSynergy 

 Permissions – List of available permissions to assign within iSynergy 

 ProductSettings – Installed iSynergy products 

 Queries – Saved user specific queries 

 Reports – 

 Results -  

 RoutingEvents - History of routed docs 

 RubberStamps – List of available rubber stamps in iSynergy and their attributes 

 Sessions – Current sessions open in iSynergy 

 Translations – Translations of values as referenced by the Translation Type table 

 TranslationTypes – List of translation types available in Xtractor and iDox 

 UserDefinedLists – List of UDLs with associated create and modified history 

 UserGroups – List of UserGroups in iSynergy 

 UserPermissions – User based permissions 

 UserPreferences – Specific user settings in iSynergy 

 Users – List of iSynergy users and their passwords 

 UserToGroup -  

 ViewLevels 

 Views 

 XtractorEvents – Xtractor event log 

OBJ_X Tables and Column Roles 
iSynergy assigns an objectid programmatically, not as an identity seed in SQL. As opposed to 
storing documents directly in the Espeed database, iSynergy stores documents in the iSynergy 
repository folder while creating a pointer (path to the actual document.) to the object in the 
column named ‘pointertosource’ in the _obj_x tables of the espeed database. 

For example, C:\iSynergy\repository\Checks\_obj_2_D1\_obj_2_D1_013R1.TIF The 
d1_013R1.tif represents subfolder D1 and object 013 revision 1. 

The status of the document is stored in the _obj_x tables as well. Document status reflects the 
current status of a document. Document status is helpful when attempting to determine if a 
document is searchable (status “E”). The _obj_x tables also store: 
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  The creator of each document with create date 
  The last modification date and who modified the doc 
  How many pages in the doc and if it was batched 
  The associated batch number where applicable 

Any Indexes created for a specific Application will be stored in these tables.  Additionally, the 
Application table holds the information pertaining to the _obj_x tables. 

For example, an Application called ‘Human Resources’ may have an ApplicationID of ‘3’ 
in the Applications table. This notifies you that the _obj_3 table holds the pointers to the 
documents for Human Resources. Typically, the order in which Applications were created 
corresponds to the obj_number of the table. _obj_1 is reserved for the ‘General Capture’ 
Application and folder.  

 

Application Table 

The Application table relates to the _obj_x tables, as well as the pointertosource of the document 
scanned into iSynergy and the repository and incoming folders. The repository folder holds the 
Application folders. Within each Application folder, there can be numerous subfolders. Each 
subfolder will hold a maximum number of pre-determined documents. When the folder limit is 
reached, a new subfolder is created and assigned a numeric value that is one greater than the 
previous folder. The Application table stores the number of subfolders within the Application 
folder as well as the maximum number of documents each subfolder can hold. Folders are stored 
in the column ‘currentfoldercount’. The number of documents within that folder are stored in 
‘currentobjectcount’. The subfolder number can be increased manually as needed if an error 
should arise.  
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Annotation Table 

This table stores all annotations added to documents along with the objectID of the document, the 
identity of the user who added the annotation, and the date and time it was added. 

 

Batches Table 

When documents are scanned in batches, the batch information is stored in this table. This 
information includes date, the first file name of batch and the last file name of batch. 
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Config Table 

The Config table stores the same information located in the admin menu > system options, 
including all paths and configuration information, as well as the iSynergy version number. 

DocumentStatus Table 

This table contains the standard iSynergy statuses as well as custom statuses used to create the 
iSynergy workflow.  

ErrorLog Table 

MS SQL errors are tracked in this table. 

EventLog Table 

Eventlog keeps track of all data changing events within iSynergy. The unique identifier in this 
table is the combination of objtable, objectid and eventdesc columns. When a user makes a 
change to a document, the change and all related changes are automatically tracked in eventlog. 
If a user changes or enters data, the old value is stored as well as the new data in the same 
record.  

For example, when a user sends a document to Xtractor, the event log tracks in a single 
record the status change to ‘A’.  The table then creates other records in the event log as 
the document proceeds to the status ‘E’. Each record stores the user or the product that 
initiated the change of document status. Many times, user errors can be corrected by 
querying for the correct data from the eventlog table.  Event date and time are stored with 
each record in the table.  

EventType Table 

In the EventLog table every record will have an EventType. The EventType table describes 
events, such as user login, Index change, etc.  

Full Text 

Primarily uses ftsqueue, ftshistory, ftsdata, and the _obj_x tables.  

Note: Prior to using iSynergy Full Text Service, you must make sure that full text 
capability is enabled on the SQL server. This enables the full text catalogs to be created 
and stored in SQL. 

Once full text has been set up to run on an Application, the documents in the related obj_x table 
are moved to the ftsqueue table in preparation for the service to run and process the documents. 
Once the FTS service runs, the records that store the processing data are moved to the ftshistory 
table. This table also stores the information if an error has occurred on a specific document. This 
provides the DBA with information to research why any document may fail.  

For example, if a document is queued up to run through FTS service, but prior to the 
service running a user deletes the document, FTS will produce an error. The service may 
“hang” for a long period because in layman’s terms, it is looking for ‘E’ status documents 
to process and it is looking for the deleted document with an ‘E’ status, when in fact, the 
deleted document now is in ‘X’ status. It is usually best to double check the ftsqueue 
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table when users are soft deleting documents from an Application that runs through full 
text.  

The actual FTS binary information is stored in the ftsdata table. This table stores the information 
for the corresponding SQL catalog. Regardless of which iSynergy Suite product was involved, all 
changes to data are recorded in the Espeed eventlog table. Along with this table, there is a 
ProcessAging view that captures the data from eventlog by object and calculates the number of 
days the object was in a particular state for each eventdesc.  

For example, if a document has a status of ‘P’ for a period of time and the status then 
changes to ‘E’ , the process aging view will store the number of days the document was 
in ‘P’ status prior to changing to ‘E’ status. 

FTSData 

This is the Full Text Service data table. This table stores the binary data for each document that 
has been processed by the Full Text Service. FTSData stores an Ftsid, objectid and 
Applicationid. This table also stores the raw data and date and time full text service ran.  

FTS History Table 

If an error occurs during the FTS Service, it is stored in this table. The history of documents that 
have been processed by the Full Text Service is also contained in this table. 

FTSQueu Table 

Documents waiting for Full Text Service are stored in this table.  

GroupPermissions 

When a group is created, the groupid and name is stored in the usergroups table. When you 
associate permissions to that group, this information is stored in the grouppermissions table and 
each permission is pulled from the permissions table by a permissionsID. There is also a view in 
Espeed called GroupPermissionsbyUser view to see an overview of permissions at the group 
level. 

ImportMapper 

This product imports a CSV file from another system. The CSV file contains a path to the images 
as well as the Indexing on the images. When ImportMapper is opened and a CSV import file is 
assigned, the mapping fields need to be filled to allow the service to automatically populate the 
fields. Once you save and close ImportMapper, the data is entered into the Espeed database 
according to the mapped fields. The ImportMapper service needs to be run each time an import 
of images from another system needs to be performed. 

IndexesTables 

This table stores the Indexes, the Application(s) in which they are used, Indexname and type, and 
any validation that exists. The Indexes table reveals if the Index is a required field, its default 
value (if any), whether it can be edited, and if sorting and grouping are associated with the Index. 
If you want iSynergy to track changes for a specific Index, set the column ‘logchanges’ to true 
(this is the default setting). 
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IndexMapping Table 

When an Application is linked to the ‘IndexMapping’ table then the drop-down control is active in 
QuickIndexer and iScan. The only other table that ‘IndexMapping’ interacts with is the 
Applications table (MapID).   

IndexType Table 

When a UDL is created, its entry is stored the Indextypes table. The data type for a UDL  is 
‘select’, indicating there is list from which to select this value. The actual values within the list are 
stored in the UserDefinedLists table. The values are grouped together by an internally used 
groupid, that groups these items for display in the UDL drop-down list within iSynergy. 

Permissions 

This table stores all permissions assigned on the user and group configuration pages in iSynergy. 
Each permission is assigned a corresponding ID number that relates to the group permissions 
table and the user permissions table.  

ProductSettings 

This table stores the Installed iSynergy products with a corresponding ID number. 

Queries 

This table stores queries created by the user in the Search Page of iSynergy. The table assigns 
and stores a query ID to created queries and also stores the user name of the user defining the 
query. The actual search criteria of the query is stored in the column ‘querystring’. The column 
‘application’ holds information for the Application within which the query was created.  

Reports 

Standard reports for iSynergy are stored in this table. 

RoutingEvents 

This table stores the routing history of documents within iSynergy. This history information 
includes the original Application and objectID as well as the Application receiving the document 
and the new objectID in that Application. Date routed is also stored in the ‘RoutingEvents’ table.  

RubberStamps 

Standard and custom rubber stamps are stored in this table. All stamps formatting settings are 
stored in the ‘RubberStamps’ Table as well.  

Translations 

This table stores the translations used for Xtractor.  TranslationID stores each translation uniquely 
in the table, the translationTypeID relates it to the translationTypes table. Original value would be 
the literal original word or words, and the translated value would essentially be the abbreviated 
value to be used in iSynergy.  
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For example, creating a bar code with a string of words that is too long for the barcoder, 
can be handled by creating an abbreviated value for the string. For instance, 
ApplicationToRouteDocumentsToHumanResources = ATRDTHR. Xtractor would read 
ATRDTHR and translate this to the literal string in the table.  

UserDefinedLists 

The groupID is used to identify documents in the same UDL.. Each UDL is given a listID but can 
have many documents that are related in there, thus identified by a groupID.  ListItem defines the 
name of the item within the group 

UserGroups 

When permissions are set up on a group level, the users are sorted into groups, and the related 
group identifier is stored here.  

UserPermissions 

This table stores all permissions for all users when User Level permissions are used. Each 
permission for each user is stored as an individual record. PermissionID relates to the 
permissions table.  

Users 

This table stores all user information including userID and Password information. Also stored here 
is info relating to user as an http viewer. When a user is added to iSynergy, relevant information 
is stored in the user table. When permissions are applied to that user, the userID from the user 
table is entered into the userpermissions table with each associated permission. If the user is 
then added to a group, an entry is made into the usertogroup table, and is associated by userID 
through this table to the group permissions table that stores permissions by groupid. 

UserToGroup 

This table stores the information as to which users are assigned to which groups. 
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iSynergy Conceptual Schema 

 


